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CHAPTER 3 —
Using The Windows 7 Desktop

ABOUT THE BOOK

See It Done. Do It Yourself.

It’s that Easy! Easy Microsoft Windows 7 teaches you the fundamentals
of working with Microsoft’s latest operating system. Fully illustrated steps
with simple instructions guide you through every task, building the skills
you need to master Windows 7 with ease.

LEARN HOW TO...

¢ Instantly find what you're looking for: files, programs, anything

* Manage your music and video with Windows Media Player

» Seeitall, do it all, get it all on the Web

* Have more fun with Windows 7’s built-in games

* Protect yourself from viruses, intrusions, and phishing

» Download free Windows Live Essentials bonus software

* Set up your computer just the way you want it

* Keep your computer running reliable and fast

* Build a home network the easy way with HomeGroup

 Put live and Internet TV on your PC with Windows Media Center

ABOUT THE AUTHOR

Mark Edward Soper has been using Microsoft Windows
ever since version 1.0, and since 1992, he’s taught
thousands of computer troubleshooting and network
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Windows XP, and Windows Vista; Easy Windows Vista; Windows 7

in Depth, and has written two books about Windows Vista, including
Maximum PC Microsoft Windows Vista Exposed and Unleashing
Microsoft Windows Vista Media Center.

Google
E Bookmarks .5 Delicious @ Digg n Facebook @ StumbleUpon ‘Gﬁ Reddit t . Twitter

quepublishing.com/windows7

ALWAYS LEARNING PEARSON


http://www.quepublishing.com/store/product.aspx?isbn=0789739941
http://my.safaribooksonline.com/book/operating-systems/9780768692389
http://www.google.com/bookmarks/mark?op=edit&amp;bkmk=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://del.icio.us/post?url1=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://digg.com/submit?phase=2&amp;url=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://www.facebook.com/share.php?u=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://www.stumbleupon.com/submit?url=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://reddit.com/submit?url=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://twitthis.com/twit?url=http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&amp;Activity_Id=796
http://www.quepublishing.com/store/product.aspx?isbn=0789739941
http://www.quepublishing.com/store/product.aspx?isbn=0768692334
http://www.quepublishing.com/index.aspx
http://promo.quepublishing.com/pages/start/qlp012011-windows-7/index.html?Campaign_Id=507&Activity_Id=796
http://www.quepublishing.com/store/product.aspx?isbn=0789739941

USING THE WINDOWS 7 DESKTOP

Although the Windows 7 desktop still has a taskbar across the bottom of the
screen, it represents a huge departure from previous Windows desktops. The
new desktop makes it easier to manage programs, switch between program
windows, and find the window you want to work with now.




Hover over a taskbar icon to see a jump list of
recently opened documents or dialogs

Gadgets can now be placed

anywhere on the desktop Suck o
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STARTING A PROGRAM FROM THE START MENU

You can start a program from a desktop shortcut, but you're more likely to start a program
from the Start menu.
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0 Click the Start orb.
g If the program is listed on the left pane, click it to start it.

6 If the program is not listed on the left pane, hover the mouse over All Programs.

G Scroll to the program listing.

6 Click the program listing to start it.

2 NOTE

If the program is within a folder on the Start menu, click the folder to

End

open it; then click the program name to start the program. W



OPENING A NEW PROGRAM WINDOW

Windows 7's taskbar also makes it easy to create a new program window for a currently run-

ning program.

o Right-click on an icon in the taskbar.
e Select the program name from the jump list.

e A new program window appears.

NN
TIP E—
Use the Recent submenu to open a recently used docu-
ment. Use Pin This Program to Taskbar to keep programs
you use frequently on the taskbar at all times. Use Close
Window or Close All Windows to close open program
windows. M ——
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MAXIMIZING, MINIMIZING, RESTORING, AND RESIZING
A WINDOW

Windows 7 provides a variety of ways to control the size and position of program windows.
In this section, you learn how to use your mouse to adjust window size and position. You can
also use Aero Snap (this chapter, p. 28) to adjust window position from the keyboard.

0 Click the upper-left corner to display the menu (optional).

e Click either control to minimize the window to the taskbar.
e Click either control to maximize the window to full screen.
O Click and drag to resize the window.

6 Click and drag to move the window.

Q NOTE

You cannot drag a maximized program window. M

) —
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Click the upper-left corner to display the menu (optional).

Click either control to restore the program to its previous window size/position.

As you can see from this tutorial, you do not need

to open the upper-left corner menu to work with

window sizing. M




USING AERO SNAP TO MANAGE WINDOWS

If your system uses the Windows Aero desktop, you can use your keyboard to move, maxi-
mize, or minimize the active window by using a new feature called Aero Snap. Aero Snap
uses the Windows key along with the arrow keys to adjust window position.

0 Program running in window.
e Press Window+right arrow keys.
6 Active window moves to right of screen.

Continued

>~% NOTE

If you are using a built-in keyboard on a portable
computer, the Window key might be located away
from the arrow keys. W




o Press Window+up arrow.
6 Active window is maximized.
O Press Window+left arrow.

6 Active window moves to left of screen.

End

Q NOTE

Press Window+down arrow to minimize active win-
dow to toolbar. M

Q NOTE

To learn more about Windows Aero, see Chapter 12,

“Personalizing Windows 7.” M




USING AERO PEEK TO VIEW THE DESKTOP
If your system supports the Windows Aero desktop (the title bar of the active window is
translucent when it is not maximized), you can use a new feature called Aero Peek to see

your desktop, even if you have many program windows open.

(Start)
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0 The Aero Peek control box. Hover the mouse over the box to view the desktop.

e Aero Peek displays only the outlines of open windows.

e Click the control box to toggle window display on and off.

i 4

2 NOTE

Windows 7 Starter Edition does not support
Windows Aero. M




USING ALT-TAB TO CYCLE THROUGH PROGRAMS

Use the Alt-Tab keys (also known as “cool switching”) to select which program you want to
make active. In Windows 7, pressing Alt-Tab cycles through live thumbnails of each running

program.

Start
K__ 7

0 Press Alt-Tab.
6 Thumbnails of active programs appear.
6 Press Alt-Tab until desired program is highlighted.

0 Release Alt-Tab, and program becomes active.

End,

}_% NOTE

In addition to the highlight shown in Step 3, the
name of the program window is shown above the

program thumbnails. M R ————




USING WINDOWS FLIP (WIN-TAB) TO CYCLE THROUGH
PROGRAMS

Systems running the Windows Aero desktop can use Windows Flip to cycle through running

programs and select the one they want to make active. Windows Flip uses the Windows and
Tab keys.

0 Press the Windows and Tab keys.

9 Running programs are displayed in an overlapping arc across the screen.

e Continue to press the Windows and Tab keys until the program you want to make active is
at the front of the stack.

O Release the keys, and the program becomes active.

End

Q NOTE

You might see icons for minimized programs as well

as program windows appear in Steps 2 and 3. W




USING THE TASKBAR TO VIEW AND SELECT RUNNING
PROGRAMS

The Windows 7 taskbar not only looks different than the one in previous versions of Win-
dows (it uses icons, not text, by default), but it makes it easier than ever to choose the

program you want to make active.

& . e I T ] =¥

BT Ry R

0 Hover the mouse over a taskbar icon, and a thumbnail of the running program appears.

e Click the taskbar icon for the program, and the program becomes active.
9 A program icon on the taskbar can represent more than one window.

o Move your mouse to highlight the window you want to make active.

1
I

I

ﬁ 1 IEE=y
>< NOTE l09=i§mj

This feature requires Windows Aero. M




CLOSING A PROGRAM

Windows 7 offers several ways to close a program, so you can select the method that's best
for a given situation.

(3

Start

0 Click the red X in the upper-right corner of the program window to close the program.
e You can also click the upper-left corner to open the window menu.
6 To close the program from the window menu, click Close.

O To close a program from the keyboard, press Alt-F4.

Continued

Q NOTE

You don't need to open the window menu to use

% NOTE

The right-click menu shown in Step 6 also allows you

Alt-F4 to close the program window.

to pin the program to the Taskbar for faster access. W
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6 To close a program in the taskbar, right-click the program icon and select Close Window.

To close all windows for a particular program from the taskbar, right-click the program icon
and select Close All Windows.

End,




USING DESKTOP GADGETS

Windows 7 improves Windows Vista's use of gadgets (small desktop programs) by freeing
them from the side of the monitor. In Windows 7, you can place desktop gadgets wherever
you'd like on the desktop, and you can use gadgets developed for Windows Vista as well as

those developed for Windows 7.

0 Right-click an empty portion of the desktop.

e Select Gadgets.

e The Desktop Gadget Gallery appears.

To place a gadget on your desktop, double-click the appropriate icon or drag the gadget to
the desktop.

Continued,
A\ i 4

Q NOTE

Repeat step 4 until you have added all the gadgets
you want to add to your desktop. B

Q NOTE

You can also open the Desktop Gadget Gallery from
the Start menu. M
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To adjust settings for any gadget, move your mouse to the right side of the gadget and
select the setup (wrench) icon.

o Select or enter the desired options and click OK when finished.

a To drag a gadget, move the mouse to the right of the gadget and click Drag Gadget.

e Move the gadget as desired, and release the left mouse button to place the gadget.

Q NOTE

Use the Get More Gadgets Online link to download
additional gadgets. @

Q NOTE

Select a gadget; then click Show Details to learn
more about the gadget. B




CHAPTER 10 —

Creating Movies and DVD Videos

ABOUT THE BOOK

Need answers quickly?

Microsoft Windows 7 on Demand provides those answers in a visual

: step-by-step format. We will show you exactly what to do through
WI ndDWS ? lots of full color illustrations and easy-to-follow instructions.
~=on Demand

INSIDE THE BOOK

* Master the Windows 7 user experience, including Windows Aero
* Perform Instant Searches to quickly find files and programs

SAVE 30% — * Manage files and information using Windows 7 programs and

FREE U.S. SHIPPING desktop gadgets

* Browse the Web, search for information, and get instant updates
* Use Windows Live Essentials to work with mail, messages,

Buy the print or eBook from photos, and movies

Que Publishing and SAVE 30% — * Protect your computer from Internet or network intruders

Enter coupon code 0

Create your own movies, slide shows, and DVDs

QWIN730 at checkout.

* Rip, manage, and play digital music and videos

* Share files and media on a HomeGroup or network
» Set multiple users and parental controls

» Customize, fine-tune, and administer Windows 7

ABOUT THE AUTHOR

Steve Johnson has written more than 45 books on a

variety of computer software, including Adobe Photoshop

CS4 and CS3, Adobe Flash CS4 and CS3, Dreamweaver

. 9780789742018 — Book CS4 and CS3, Adobe InDesign CS4, Adobe lllustrator CS4,

Microsoft Office 2007 and 2003, Microsoft Windows

V ElEpenss - dlBenle Vista and XP, Microsoft Expression Web 2, Microsoft Office 2008 for the
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Creating Movies and
DVD Videos

Windows Live Movie Maker (version 14) (New!) lets you com-
bine video, audio, and image files with special effects to cre-
ate movies and slide shows you can publish and show on
your computer or CD/DVD, e-mail to others, or place on a
web page or mobile device. Windows Live Movie Maker is a
new program—>built from scratch—that replaces Windows
Movie Maker (installed by default in Windows Vista).
Windows Live Movie Maker doesn’t come installed with
Windows 7; it's available for free online from Microsoft. You
can download this program as well as other program tools
from Windows Live at http://download.live.com.

In Windows Live Movie Maker, you create a project that
contains the arrangement and timing information of audio
and video clips, video transitions, video effects, and titles.
You can drag video and audio clips from the storyboard.
After you arrange the video and audio clips in the sequence
you want, you can add video transitions, video effects, and
text. After you preview your project using the monitor, you
can publish it as a movie file to your computer, a recordable
DVD, or send it to sharing sites on the web, such as Soapbox.

The movie you create can be watched in a media player,
such as Microsoft Windows Media Player, or in a web
browser. If you would rather create a DVD, you can output
the movie in a DVD format (.wmv) from Windows Live Movie
Maker, and then burn the file to a DVD or use it in Windows
DVD Maker. In Windows DVD Maker, you can insert additional
video, pictures, and audio, add DVD titles and menus, and
specify publishing options before you burn the movie to a
DVD.

Plan a Movie Maker Project
Start Windows Live Movie Maker

View the Windows Live Movie Maker
Window

Open an Existing Project

Use Photos and Videos from Photo
Gallery

Add Photos and Videos

Add Slides to a Movie

Add a Soundtrack

Work with Clips

Add Text

Trim Clips

Add Transitions Between Clips
Add Photo and Video Effects
Save a Movie Project and a Movie
Add Functionality with Plug-ins
Publish a Movie

Create a DVD Video

281



Planning a Movie Maker Project

Windows Live Movie Maker lets you combine
video, audio, and image files to create movies
and slide shows you can publish and show on
your computer or CD/DVD, e-mail to others,
or place on a web page or mobile device. You
save the movie you create as a file, just as
you would save a word processing or spread-
sheet file, and you can play and view it at any
time. However, movies and their accompany-
ing files are larger than most other docu-
ments you create—usually exceeding 5 MB.
Before you begin, it's a good idea to plan your
content.

Your movie might be a promotional piece or
catalog for business use, or a vacation movie
to share with family and friends. Your purpose
determines the subject, type, and quality of
the source material, which is the video and
audio material you will use.

You might want to show your movie on a
computer projection screen at a meeting,
send it as an attachment in an e-mail mes-
sage, or place it on a web site. When you
place a movie on a web site, viewers might
download it, which means to transfer it to
their computers and store it for future view-
ing. If your movie is very long or has many
high-quality images, the movie file will be
large and will take a long time to download.

Chapter 10

If you have a digital video or digital web cam-
era, you can record or capture digital images,
and then import them into Movie Maker.

To use existing video or audio segments,
called clips, you must import them, or bring
them into Movie Maker.

Before putting your movie together in Movie
Maker, it's important to make a sketch of your
movie that shows the order of the audio and
video components. What audio clips do you
want to play with what video clips?

First, you bring clips of source material into a
Movie Maker project file. A project file, which
is the working copy of your movie, is a Movie
Maker document with the file name extension
.mswmm. You then use the project file to do
the following: set the order of your movie
segments; trim (delete) portions of clips you
don’t want to use; specify how clips display
from one to the next, called transitions; add a
video special effect to clips; add titles and
credits to the beginning and end of the movie
or individual clips; and, lastly, preview your
work. Finally, you save your project file as a
movie with the file name extension .wmv and
display the completed movie using the
Windows Media Player program.



Starting Windows Live
Movie Maker

Start Windows Live Movie
Maker

Click the Start button, and then
point to All Programs.

Point to Windows Live, and then
click Windows Live Movie Maker.

If an alert appears, asking you to
save changes to My Movie, click
Yes or No.

My Movie is the default movie file
for Windows Live Movie Maker.

If you select Yes, select a location,
and then click Save.

A blank new movie (default My
Movie) appears in the Windows
Live Movie Maker window.

To exit Windows Live Movie
Maker, click the File button, and
then click Exit.

See Also

See “Changing the Display” on page
105 for information on changing the
screen resolution.

Windows Live Movie Maker (New!) doesn’t come installed with
Windows 7, so you need to download and install it from the Microsoft
Windows Live. This chapter describes version 14 beta; your down-
loaded version with updates may differ slightly; select Options on the
File menu for version information. Before you start Windows Live Movie
Maker, use Display Properties in the Control Panel to make sure the
screen resolution is set correctly. Windows Live Movie Maker is a pro-
gram that you can start from the Start menu. You achieve the best
results in Windows Live Movie Maker when the screen resolution is set
to 1024 by 768 or higher. When you start Windows Live Movie Maker, a
new untitled movie project is displayed. You can either create a new
movie project or open an existing one.

n LR i o e g o b

i b e
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Viewing the Windows Live Movie Maker Window

Ribbon Storyboard
The Ribbon displays the File menu The Storyboard displays a sequence of
and tabs with button commands. clips and photos in your movie project.

Playback controls Monitor
The Playback controls allow you to The monitor displays individual
playback the movie. clips or an entire project.
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Opening an Existing
Project

Open an Existing Project

Click the Start button, point to All
Programs, point to Windows Live,
and then click Windows Live
Movie Maker.

Click the File menu, and then click
Open.

Select the drive and folder that
contains the project you want to
open.

Select the project file.
Click Open.

Did You Know?

You can quickly reopen a recently
opened movie. Click the Start button,
point to Windows Live Movie Maker,
and then click the movie you want to
reopen.

You can create a new movie in
Windows Live Movie Maker. Click the
File button, and then click New.

After you save a project in Windows Live Movie Maker, you can open it
and continue to work on the project. A Movie Maker project file is

saved with a.mswmm file name extension, which you can open using
the Open command on the File menu. The project file's extension will

change, once the project is finalized.
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Using Photos and
Videos from Photo
Gallery

Create a New Movie with
Photos and Videos from Photo
Gallery

Click the Start button, point to All
Programs, point to Windows Live,
and then click Windows Live
Photo Gallery.

Select the photos and videos you
want to use in a movie.

Click the Movie button on the
toolbar, and then click Make a
movie.

Windows Live Movie Maker
opens, displaying the photos and
videos from Windows Live Photo
Gallery in the Storyboard.

Did You Know?

Twenty hours of video take a gigabyte
of hard disk space. You can store
more than 20 hours of video for each
gigabyte of hard disk space on your
computer.
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If you installed Windows Live Photo Gallery (New!) on your computer
along with Windows Live Movie Maker, you can use the program to
quickly import photos and video directly into Windows Live Movie
Maker. Windows Live Photo Gallery comes with a Make a movie com-
mand on the Make menu, which connects the program with Windows
Live Movie Maker. The command transfers selected photos and video
to a new or open movie in Windows Live Movie Maker (New!).
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Add Photos and Videos from
Photo Gallery into a Movie

Click the Start button, point to All
Programs, point to Windows Live,
and then click Windows Live
Movie Maker.

Click the File menu, and then click
Open.

Select the drive and folder that
contains the project you want to
open.

Select the project file.
Click Open.

Click the Start button, point to All
Programs, point to Windows Live,
and then click Windows Live
Photo Gallery.

Select the photos and videos you
want to use in a movie.

Click the Movie button on the
toolbar, and then click Make a
movie.

Windows Live Movie Maker
appears, displaying the currently
opened movie with the photos and
videos from Windows Live Photo
Gallery added into the Storyboard.
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If you want to use existing video and audio clips in your movie instead
of recording them yourself, you can obtain them from various compa-
nies that specialize in video processing, or you can download them
from the web. Commercial CDs/DVDs are excellent sources for audio
clips. You can import the video and audio clips into Windows Live
Movie Maker from files on your computer, from your CD/DVD drive, or
from the web. You can use the Add videos and photos button on the
Home tab or drag photos and videos directly to the Storyboard. If you
no longer want a photo or video in the Storyboard, you can remove it.

Adding Photos
and Videos

Add Photos or Videos to a Movie

Click the Home tab. ?

Click the Add videos and photos [ ] ’ N =
button on the Ribbon. Bl s ¢ e s A e .

R —— B [N
Select the folder that contains the - i L -
photo or video files you want to . o
use. i . ““ ,i, ! i
To select a specific media type, r '::::-1' el e :w e
click the Files of type list arrow, S ﬂ: E u
and then select a file type. L gy = | xl

L | b LI “ha s

Select the files you want to use. W oot
TIMESAVER To import several e, e et I"*"‘"'“"""':'“'_o
files at one time, press and hold S

down the Ctrl key, and then click
each file that you want to use.

Click Open.

C Movie Maker Import File Types

File Type File Extensions

Video .wmy, .avi, /dvr-ms, .mpg, .mod, .vod, .asf, .m1y,
.m2ts, .mp2v, .mpe, .mpeg, .mpv2, .wm, .3g2,
.3ap, -3gp2, .3gpp, .asx, .m2t, .m2v, and .m4v

Photos and Pictures .Jpg, .png, .bmp, .dib, .rle, .gif, .ico, .icon, .jpeg,

Jpe, ffif, . exif, tiff, .tif, and .wdp

N /

288 Chapter 10



Drag Photos or Videos into a
Movie

Open Windows Explorer and
display the media files you want to
use.

Start Windows Live Movie Maker,
and then create or open the movie
in which you want to add photos
or videos.

Display the windows next to each
other; right-click the taskbar, and

then click Show windows side by
side.

Drag the media files from
Windows Explorer to the
Storyboard in Windows Live
Movie Maker.

T e

Photos in Windows Live
Movie Maker
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Adding Slides to
a Movie

Create a Slide Show Movie

Click the File button, and then
click New.

Click the Add videos and photos
button on the Home tab.

Select the folder that contains the
photo files you want to use.

To select a specific media type,
click the Files of type list arrow,
and then select a file type.

Select the files you want to use.

TIMESAVER To import several
files at one time, press and hold
down the Ctrl key, and then click
each file that you want to use.

Click Open.

Click the File button, click Save as,

navigate to a folder location, type
a name, and then click Save.

290 Chapter 10

Instead of using video clips, you can create slide shows in Windows
Live Movie Maker with still images that you create using a digital cam-
era, web camera, or scanner. You can import the clips into Windows
Live Movie Maker and create transitions between them, just as you
would in a movie. You can change the duration of individual photos. You
can also add a sound clip to create a sound track that plays as your
photos appear on the screen. Portrait-oriented pictures in Movie Maker
are the same height as landscape-oriented pictures, and Movie Maker
inserts a black background on either side of each one.
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Arrange Photos in a Slide Show

Create or open a slide show
movie.

Select the photos you want to
move.

Drag the selected photos to a new
location in the order you want.

Set Photo Duration in a
Slide Show

Create or open a slide show
movie.

Select the photos you want to use
in the movie.

Click the Edit tab.

Click the Duration list arrow, and
then select the photo duration in
seconds.
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Addlng a Soundtrack If you have photos or video without sound, you can add a soundtrack to

a movie. Windows Live Movie Maker allows you to add a single audio
or music file to your movie. You can use audio or music with the WMA,
MP3, or WAV file formats. If you want to use multiple audio or music
files in a movie, use an external sound editing program to combine
them together before you use it. You can use the Add music button on
the Home tab to insert it. When you insert a soundtrack file when one
already exists, the new one replaces the existing one. If you no longer
want to use a soundtrack file, you can remove it. In addition, you can
also set the soundtrack and video to play at the same volume or make
one louder than the other, and adjust the duration of your movie to
match your soundtrack.

Add an Audio or Music
Soundtrack
Open the movie in which you want

to fit the sound clip to the length of
the movie.

Click the Home tab.

Click the Add music button on the
Ribbon.

Select the folder that contains the
audio or music file you want to
use.

To select a specific media type,
click the Files of type list arrow,
and then select a file type.

Select the files you want to use.

Click Open. e
i e |
Y =y = — . Er— 7
e 0
Did You Know? Wissr |y t
You can remove a soundtrack. Open s iy e
the movie with the soundtrack you el it
want to remove, click the Remove i T O
. e »
Music button on the Home tab. Fam R
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Fit the Soundtrack to the Movie

Open the movie in which you want
to fit the sound clip to the length of
the movie.

Click the Home tab.

If not done, click the Add music
button on the Ribbon to add a
soundtrack file to the movie.

Click the Fit button to adjust the
duration of your movie to match
your soundtrack.

Mix the Soundtrack

Open the movie in which you want
to adjust the sound clip.

Click the Home tab.

If not done, click the Add music
button on the Ribbon to add a
soundtrack file to the movie.

Click the Mix button.

Drag the slider to adjust the
volume mix between the
soundtrack and the video.
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Working with Clips

Preview a Clip

Open the movie in which you want
to work with clips.

Click the clip in the Storyboard you
want to preview.

Right-click the selected clip, and
then click Play.

TIMESAVER Press Spacebar
to play or pause a clip quickly.

To pause the clip, click the Pause
button. Click the Play button again
to continue.

To adjust the start point, drag
the Seek bar to the place you
want.

Did You Know?

You can get ScreenTip information
about a clip. Point to a clip in the
Storyboard to display name and dura-
tion of the clip.

294  Chapter 10

After you capture or import a video clip or audio clip, you can preview
the individual clips in the monitor. The monitor works similarly to a
VCR/DVD. The Storyboard displays all the clips and photos in a movie.
The order in which they appear in the Storyboard is the order it
appears in the movie. You can rearrange the individual items by simply
dragging them to a new location in the Storyboard. If you no longer
want to use a clip, you can remove it.

Seek bar e



Arrange Clips in a Movie

Open the movie in which you want
to work with clips.

Select the clips you want to move.

Drag the selected clips to a new
location in the order you want.

Remove Clips from a Movie

Open the movie in which you want
to remove clips.

Select the clips you want to
remove.

Click the Home tab.

Click the Remove button.

Did You Know?

You can cut and copy clips in
Windows Live Movie Maker. Open the
movie in which you want to work with
clips, select the clips you want to cut
or copy, right-click the selection, and
then click Cut or Copy.
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Addlng Text You can add text titles a}nd credits to your movies. You can add any text
you want, such as the title of your movie, your name, captions, and

credits at the end. You can add a title at the beginning of a movie,
before or after a clip, or overlapping a clip or credits at the end of a
movie. You add text in Windows Live Movie Maker just like you would
in Paint with a Text box. Like Paint, if you click outside the text box, you
can't change it. It becomes part of the clip. When you insert text in a
video, the text appears throughout the entire video. You can also
change the appearance of the text using the font formatting options on
the Edit tab.

Add and Edit Text to a Movie

Open the movie in which you want
to add text.

Click the Edit tab.

Select the clip you to which you
want to add a title.

Click the Text box button.

A blank text box appears on the
monitor.

IMPORTANT /f you click
outside the text box, you can't
change it. It becomes part of
the clip.

To move the text box, point to the
edged of the box (4-headed
arrow), and then drag it.

Click in the box, if necessary, and
then type the text you want to
appear as the title.

To adjust the size of the text box,
point to a size box in the corners
or middle edges, and then drag it.

To edit the text, click in the text
box, and then modify or format the
text.

When you're done, click outside
the text box.
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Add and Format Text to a Movie

Open the movie in which you want
to add text.

Click the Edit tab.

Select the clip to which you want
to add a title.

Click the Text box button.

A blank text box appears on the
monitor.

IMPORTANT /f you click
outside the text box, you can't
change it. It becomes part of
the clip.

Use the options under Font on the
Edit tab to format the text:

Font Type.
Font Size.
Bold.

Italic.

Font Color.
Grow Font.
Shrink Font.

Click in the box, if necessary, and
then type the text you want to
appear as the title.

To adjust the size of the text box,
point to a size box in the corners
or middle edges, and then drag it.

To move the text box, point to the
edged of the box (4-headed
arrow), and then drag it.

When you're done, click outside
the text box.
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T"mmlng CIlpS Frequently, the clips you record or |mport.|nto Wlpdows L|.ve Movie
Maker run longer than you want them to in your final movie. You can

easily trim clips on the Trim tab by playing the clip and setting the trim
beginning point and trim end point. The portion between the trim points
remains in your movie. The frames before and after the trim points are
deleted from your movie, but the original clip is not affected and retains
its original length. You can trim a clip as it plays, or you can pause and
set the trim points. You can drag the timeline trim handles (sliders at
the beginning and end of a selected clip).

Trim a Video Clip

Open the movie in which you want
to modify clips. | 37

Click the Edit tab.

Select the video clip you want to " Fet——

trim in the movie. - [ ﬂ ﬂ

Click the Trim button. ' ﬁ i ﬁ m

Drag the Seek bar to the point ﬁ e

where you want to start the clip.

Drag the left slider to the point
where you want to start the clip. '

Drag the Seek bar to the point
where you want to end the clip.

Drag the right slider to the point
where you want to end the clip.

Click the Save and close button to

save and exit the Trim tab or click e L ZEE

Cancel to exit without saving your "l_" .
‘H

work.
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Adding Transitions
Between Clips

Add or Remove a Transition

Open the movie in which you want
to add transitions.

Click the Visual Effects tab.

Select one or more photo or video
clips you want to add a transition
in the movie.

Click a transition on the Ribbon.

A gold border appears around the
transition box on the Ribbon to
indicate it is applied to the photo
or video clip.

To remove a transition, click the
No transition (first box) on the
Ribbon.

To test out the transition, click the
Play/Pause button.

To increase or decrease the
transition duration, click the Edit
tab, and then change the duration
time in seconds.

A transition is an effect that provides a smoother, more gradual change
between clips in a movie. A transition plays before one clip ends while
another starts to play. You can add a transition between two video
clips, pictures, or titles on the storyboard or timeline. Windows Live
Movie Maker provides a variety of video transitions that you can
quickly add to a movie project, such as Crossfade, Slide, and Roll. If you
no longer want to use a transition, you can remove it.

Chapter 10 Creating Movies and DVD Videos 299



Addlng Photo and Windows Live Movie Makgr oﬁgrs a variety of Black gnd Whitg effects
that you can add to a movie project, such as orange filter, red filter, yel-
Video Eﬂects low filter, sepia tone, or cyan tone. An effect is applied for the entire
duration of a clip, photo, or text in a movie project. If you no longer
want to use an effect, you can remove it.

Add or Remove Effects

Open the movie in which you want
to apply an effect. i — - ——
Click the Visual Effects tab. . Eetnnn-—®O0

Select one or more photo or video
clips you want to apply an effect in
the movie.

Click an effect on the Ribbon.

A gold border appears around the
effect box on the Ribbon to
indicate it is applied to the photo
or video clip. '

To remove an effect, click the No
effect (first box) on the Ribbon.

To test out the effect, click the
Play button.
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Saving a Movie
Project

Save a Movie Project

Create or open the movie you want
to save in the default Windows
Live Movie Maker format
(.mswmm).

Click the File button, and then
click Save as.

Select the folder where you want
to save the project file.

Type a movie project name.

Click Save.

If you're still working on a project, you can save the project file and

open it later to continue working with your movie. A saved project file
in Windows Live Movie Maker has an .mswmm file name extension. In

Windows Explorer, you can include general information using tags, like

any other file, about the movie, such as the title, author, copyright, a

rating, and a description, that is often displayed during playback by

many media players.

[
| 11 s o
P
SN A —
ferm i o 1]
-
r] ap—— R
g Wlam
Y — i Fy Ly
Bl i g S
W i =
Zels rims Pl SR
—
(H I i
L-I"I
L e
g M b e
= ke Frbdery

Movie Maker Project
with the .mswmm
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= = A movie project is saved with the default .mswmm file format.

sa‘"ng a MOVlE However, if you want to use your movie on a DVD or portable device,
you need to save it in a compatible format, such as Windows Media
Video (.wmv) (New!). With the Output button on the Home tab, you can
save a movie in the .wmv format: Windows Media DVD quality (640x480,
2.8Mbps, 30fps) or Windows Media portable device (320x240, 1.5Mbps,
30fps). After you save the movie, your next step is to burn it to a DVD or
sync it to a portable device. After you save the movie in the .wmv for-
mat, you can play it in a media player, such as Windows Media Player,
orin a web browser.

Save a Movie for Use on a DVD

or Portable Device
Create or open the movie you want s e L =7

to save in the .wmv format for use
on a DVD or portable device.

Click the Home tab.

Click the Qutput button arrow, and
then select an output option:

Windows Media DVD quality
(\WMV).

Windows Media portable
device (WMV).

Select the folder where you want
to save the project file.

Type a movie name.

Click Save. 1o T s e I =]

e Rkl o SR

Upon completion, an alert dialog S S S
. . . e Sl s e e Dy e

box appears, displaying options to ﬂ

view the file in Windows Explorer

or in Windows Media Player. - & ——

Click View Folder, Open, or Close.
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Burn a Movie to a DVD

Click the Windows Explorer icon ? ? ?
on the taskbar, and navigate to the

location with the movie you want A | - lacinclag
to burn to a DVD. SR o "
I Bl = B - [P ]
Select the movie that you saved Fan
using Windows Media DVD quality T i [/ ‘;_"
(WMV) in Windows Live Movie f o il
e Trer=r iy Fur iy 1y
Maker. o
Click the Burn button on the o b i
toolbar. i b i a
Insert a writable DVD into your N Do
DVD recorder. e
T: r.—..n.-. -':-\.-. J:..'\.--n =L
Click Burn files to disc. Pl i
Type a title for the disc.
Click the With a CD/DVD player
option.
Click Next to continue. [ J
Heaw il pCu aEEE L T it
Open the folder that contains the PR ey
files you want to burn, and then i LN k. e
drag the files onto the empty disc e T
folder. "';'_"d.m'"“"" g 0
TSR D e O R DT R A
Click Burn to disc on the toolbar. == '*'“‘*'w“.:-_ﬁ"“"“""“"'""“"
The selected files are copied to —
the disc. The disc recorder tray ,_;..I:-_. i
opens when the disc is complete. é
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Addlng Functionality Windows Live Movie Maker allows you to publish a movie to sharing

sites on the web, such as Soapbox on MSN video (installed by default).

with Plug-ins Windows Live Movie Maker uses plug-ins (New!) to allow this func-
tionality. Third-party developers have created additional plug-ins you
can use to upload your movies to YouTube and SmugMug to name a
few. You can open a web site from Windows Live Movie Maker that
lists and provides access to a variety of plug-ins with more to come all
the time. The plug-ins on the web site can be used in Windows Live
Movie Maker and/or Windows Live Photo Gallery, such as upload to
Facebook. Check the web site for details.

Add Functionality with Plug-ins

Create or open the movie you want Installed plug-ins

to save in the .wmv format for use - —

on a DVD or portable device. & —— = .
BE 4.8 "

Click the Home tab.

Click the Publish button arrow,
and then click Add a plug-in.

Your browser opens, displaying a
web site with a list of available
plug-ins.

To install a plug-in, click a link, and
the click the download link for the
plug-in.

Click Run or Save to run or save
the setup program, and then follow
the on-screen instructions.

Follow the on-screen instructions o
to complete the setup process Plug-i b si

D - t
and then click Finish. Hoine e st S =

B e 1
Click the File button, click Exit, [ P ' i e
and then restart Windows Live R T il e e
Movie Maker. i
WREHTAH LV PHOTO B VDI BLSE. | W S e e
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2 2 2 After you preview the final project using the monitor, you can publish
Publishing a Movie you pre 1al project using the monitor, you can p

the project file as a movie file. Using a publishing plug-in (New!), you
can publish the movie file to the web for use on sharing sites, such as
Soapbox on MSN video, YouTube, or Pixelpipe. The Soapbox on MSN
video plug-in is installed by default, while YouTube and other publishing
plug-ins need to be downloaded and installed. You can open a web site
from Windows Live Movie Maker that lists and provides access to a
variety of plug-ins. Each publishing option uses a different process to
publish your movie to the web site. In most cases, you need an account
with the web site to continue. Get an account or sign in to your account.

Publish a Movie Using Plug-ins

Create or open the movie you want Installed plug-ins
to save in the .wmv format for use

on a DVD or portable device.

Click the Home tab.

Click the Publish button arrow,
and then select a publishing
options, such as LiveUpload to
YouTube.

Each publishing option uses a
different process to publish your
movie to the web site.

In most cases, you need an
account with the web site to
continue. Get an account or enter
your user name and password.

Click Sign In.

e e P ) =

Follow the on-screen instructions
to complete the setup process.
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creating a DVD Videﬂ With Windows DVD Maker, you can insert video, pictures and audio,

and combine it with titles and predefined menus to create a DVD video
disc that you can play on a TV using a DVD player. To create a DVD,
you add and arrange your media, add menu text, select a menu style,
choose DVD playback options, and then burn it. If you have still photos,
you can also create a slide show set to music.

Create a DVD Video Using

Windows DVD Maker [2) ? ?

Click the Start button, point to All
Programs, and then click
Windows DVD Maker.

Click the Add items button, locate -
and select the media you want to Trem
insert, and then click Import.

Select a media item, and then click
the Move up or Move down button
to arrange the media on the DVD.

Click the DVD Burner list arrow,
and then select a DVD burner.

To set options, click the Options i N i . o

button, specify the options you
want, and then click OK.

Choose DVD playback settings.
Select a playback option.

DVD aspect ratio. Select a
screen ratio, either the 4:3 or —

16:9 option. T

Video format. Select the NTSC U

or PAL option. NTSC is common boiim i

in the USA and PAL in Europe. .._... DVD Options
DVD burner speed. Select the aiig

fastest possible for the DVD =

burner on your computer. SN e

Type a disc title, and then click S — ]
Next to continue.
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Click the Menu text button, specify
the text you want, and then click
Change Text.

Click a menu style in the right
pane.

To customize the menu, click the
Customize menu button, specify
the options you want, and then
Change Style.

Click the Slide show button,
specify picture length and music,
and then Change Slide Show.

Click Burn.

Click the File menu, click Save,
specify a location and name, and
then click Save.

Change menu text options

Chapter 10
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In this chapter, Windows 7 networking for the home
environment is explored.

Networking with Windows 7

HomeGroups

Setting up a home network has never been astronomically difficult, but it's frustrat-
ing enough to novice users that they often give up or pay someone to come in and
fix their networks. It's not the physical side that causes them pain. Walk into any
store that sells computer equipment and you can pick up a wireless router or what-
ever else you need that will connect your home physically in a matter of minutes.
But “sharing” your documents, printers, media and so forth is a bit more challenging
if you do not know how to do this (and even more challenging if you have a hodge-
podge of system types—some systems running XP and others running Vista).

With Windows 7, this pain point is addressed by HomeGroups, a feature that works
only between systems running Windows 7). Obviously you can still network dis-
parate systems together, but if you have an all-Windows 7 situation, the sharing is
much easier to accomplish.

When you perform an installation of Windows 7, you can configure a HomeGroup
at that time. But if you don't set it up then, you can use the HomeGroup applet
found in Control Panel to get you started. You initially see a dialog that explains
what a HomeGroup is for; click the Create a HomeGroup button (see Figure 8.1).

(g) LET METRY IT

Creating a HomeGroup

Complete the following steps to create a HomeGroup. On completion, you will
have chosen what items to share and you will receive a password to share this data
with other computers on your network.

1. Click the Start orb.

2. Click Control Panel.

3. Select Network and Internet.
4. Choose HomeGroup.

5. Click Create Homegroup to open the Create a HomeGroup dialog box.
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Figure 8.1 Creating a HomeGroup.

6. Select what you want to share from the following and click Next.

* Pictures

*  Music

e Videos

e Documents
* Printers

7. After the HomeGroup is created you will be provided a password for other
computers to access the libraries in your HomeGroup. Write down the
password.

8. Click Finish.

Keep in mind that you can always go back and easily make changes from the
HomeGroup settings through Control Panel.

If you are having trouble creating a HomeGroup, make sure you check your ver-
sion of Windows 7. Windows 7 Starter and Windows 7 Home Basic can join an
existing HomeGroup but cannot start a HomeGroup. If you're having trouble
connecting to a HomeGroup, verify your computer is actually connected to the
correct network. If you have a wireless network connection, it can be very easy
to connect to the wrong network inadvertently and spin your wheels trying to
solve a connectivity issue.

After the HomeGroup is set up, you will receive a password (see Figure 8.2). This
password is provided by default. You can write it down and share it with others in
the family so they can access shared items (so long as they have Windows 7 on
their systems) or you can change the password to something you would like.
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Figure 8.2 The HomeGroup password.

{g LET METRY IT
Locating a Lost HomeGroup Password

Follow these steps to retrieve your HomeGroup password. Once finished, you can print
this password to save it for later reference or to distribute to others on your network.

1. Click the Start orb.

Click Control Panel.

Select Network and Internet.
Choose HomeGroup.

Click View or Print HomeGroup Password.

@ U & WM

To print out the password, click Print this Page at the bottom right; otherwise
click Cancel.

Some have asked why they cannot just create their own passwords right from
the start. Apparently during the testing phase of Windows 7, the Windows
development team discovered that users weren't aware they might be giving
this password to others, so these users often used the same passwords they
used to secure sensitive information. Rather than distribute this same password
to others and potentially put their sensitive information at risk, users were given
a starter password. This gave them the option of using this starter password or
creating their own password.
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After your HomeGroup is up and running, you can revisit your settings in the Con-
trol Panel and make additional changes, such as adjustments to your media stream-
ing options (see Figure 8.3).
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Figure 8.3 Changing HomeGroup settings.
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Accessing the HomeGroup Settings
Complete the following steps to change your HomeGroup settings.
1. Click the Start orb.
2. Click Control Panel.
3. Select Network and Internet.
4

Click the Choose Homegroup and Sharing Options link, which opens the
Change Homegroup Settings screen.

Every system in a HomeGroup is considered a peer (or equal). Users can enter or
leave the group by using the password, much like the use of a key to the home.
Once in the group, they can access whatever is shared.
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Changing the HomeGroup Password

Changing your password is an easy way to stop others from sharing your library.
The following steps show you how to change your password. A later exercise
shows you how to stop sharing individual library items in a HomeGroup.

1.

2
3.
4

9.
10.

Click the Start orb.
Click Control Panel.
Select Network and Internet.

Click the Choose Homegroup and Sharing Options link, which opens the
Change HomeGroup Settings screen.

Click the Change the Password... link, which opens the Change Your
Homegroup Password dialog box.

Verify that any current HomeGroup computers are on and not asleep or
hibernating.

Click Change the Password. You will be prompted to accept the new pass-
word or change it.

Click Next.
Write down the password.

Click Finish.

One of the best parts to this is the use of Libraries. A folder such as Pictures is no
longer a folder; it’s a Library that can include multiple folders from multiple loca-
tions. You can control the addition of locations if you choose, but if Pictures is
shared out, others can quickly view those new locations without finding a new way
to connect to it. It will all come under the Library.

When it comes to sharing documents, the content is shared as read-only so that
you do not have to fear items being changed without additional thought (although
you can change this selectively, on a document basis, in Explorer; see Figure 8.4).
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Figure 8.4 Libraries that are shared with the HomeGroup.
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Sharing Additional Libraries with the HomeGroup

The following show you how to share items to your HomeGroup. In addition to
adding these items to your shared library, you can also modify how they are
accessed (such as read-only or write).

1.
2,

N G

Click the Start orb.

Select your user name. It should be in the right column at the top. This will
open your personal folder.

Click on a folder you would like to share, but do not open it.

In the top menu, click the drop-down arrow to the right of Share With.
Select HomeGroup (Read/Write).

You might be asked for a confirmation of this. If so, click Yes.

To view which Libraries are being shared, click on a folder. Look to the
lower-right of the screen, above the words Date Modified, and you will see
State:Shared.

This folder is now being shared as a library with read/write access to users in
your HomeGroup.
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Be advised that when you add libraries to the HomeGroup, those libraries need to
be present and connected in order to be accessed. For example, you can add a
folder on a removable external hard drive as a library to your HomeGroup, but it
can only be accessed when the external hard drive is connected to your computer.

If you would like to make a network resource as part of your HomeGroup, the fold-
er to add as a library needs to be indexed. If it isn't, a quick workaround is to make
the folder available offline. This indexes the folder as it creates offline versions. You
can include the folder in a library once you make it available offline. Keep in mind
that these offline versions of the files in the folder will be copied to your hard drive.
Make sure you have enough room on your local hard drive to accommodate the
offline files that you have added to your library.

("\ LET ME TRY IT
Removing Libraries from the HomeGroup

The following exercise shows you how to select exactly which library you would
like to stop sharing with your HomeGroup.
1. Click the Start orb.

2. Click your user name (it should be in the right column at the top). This
opens your personal folder.

4. Click once on a library you would like to stop sharing (but do not open it).
5. In the top menu, click the drop-down arrow to the right of Share With.

Select Nobody.

The library is now removed from your HomeGroup. However, it is still accessible
from the local computer.

Another interesting aspect of the HomeGroup approach is that it allows computers
that are typically connected to a domain at work (such as a company laptop) to access
a home network. You can join a HomeGroup and see the items in the home but others
will not be able to see back in to your system so your data is safe from prying eyes.

{g) LET METRY IT

Removing Your Computer From a HomeGroup
You can easily leave a HomeGroup. Follow these steps to accomplish this.

1. From the computer you want to remove from the HomeGroup, click the
Start orb.

2. Click Control Panel.
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Select Network and Internet.
Select HomeGroup.
Choose Leave the HomeGroup.

Click Leave the Homegroup.

N o »n =W

Click Finish.

From within the HomeGroup options you can also access your media sharing set-
tings and your Advanced sharing settings. Click Change Advanced Sharing Settings.

If you are having trouble with sharing in the HomeGroup, Windows 7 provides a
HomeGroup troubleshooter (see Figure 8.5) to diagnose and locate potential problems.
By default, the troubleshooter is configured to apply repairs automatically. This is a nice
feature that helps minimize support calls and lets the operating system self-heal.
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Figure 8.5 The HomeGroup troubleshooter.
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Using the HomeGroup Troubleshooter

The following steps how you how to identify issues with computers already connect-
ed to a HomeGroup. These steps work only on computers already connected to a
Homegroup. To join a HomeGroup, visit the HomeGroup applet in the Control Panel
to connect to an existing HomeGroup.

1. Click the Start orb.
2. Click Control Panel.

3. Select Network and Internet.
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4. Click on HomeGroup.

5. Inthe Other Homegroup Actions section, click Start the HomeGroup trou-
bleshooter. The HomeGroup troubleshooter dialog box opens up.

6. Click Next. The troubleshooter begins searching for problems and auto-
matically fixes them (if possible).

7. Follow the wizard to complete the troubleshooter.

Public folder sharing (which is turned off by default) can be another easy way to
share files and folders. Public folders are a quick and easy way to share a file with-
out setting up an entire folder as a library. The weakness of public folders, however,
is their inability to restrict users to seeing only the files in the Public folder. Also,
there isn't much in the way of permissions. Generally speaking, if it can be seen in
the public folders, it can be accessed. Still, if you want to share a file only temporar-
ily with someone, public folders are the way to go.

Access this video file through your registered Web Edition at

SHOW ME Media 8.1—Working with HomeGroups
my.safaribooksonline.com/9780768695212/media.

(1)
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Turning on Public Folder Sharing

After you complete the following steps, members of your network will be granted
access to all items located in your Public folder. They will have full rights to all files
in the Public folder.

1. Click the Start orb.

2. C(lick Control Panel.

3. Select Network and Internet.
4

Click the Choose Homegroup and Sharing Options link. The Change
HomeGroup Settings screen opens.

v

Click Change Advanced Sharing Settings.

6. Locate the Public Folder Sharing section.

You have two different profiles with Public Folder sharing options. One is the
Home/Work profile (which is most likely where you want to turn on this feature)
and the other is the Public profile (which you typically want to keep locked
down a bit more, so you may not want to enable it here).



174 Chapter 8 | Networking with Windows 7
7. Choose Turn On Sharing So Anyone with Network Access Can Read and
Write Files in the Public Folders.
8. Click Save Changes.
9. A UAC window might open. If so, click Yes.

Workgroups, HomeGroups, and Domains:
What's the Difference?

For years, Windows networks have existed as either workgroups or domains. Now
HomeGroups have been introduced with Windows 7. Domains, workgroups, and
HomeGroups represent different methods for organizing computers in networks.
The main difference among them is how the computers and other resources on the
networks are managed.

Here's a brief look at each of the key features (source: Windows 7 Help and Support):

Workgroup
e All computers are peers; no computer has control over another computer.

e Each computer has a set of user accounts. To log on to any computer in the
workgroup, you must have an account on that computer.

» There are typically no more than 20 computers.
» A workgroup is not protected by a password.

e All computers must be on the same local network or subnet.

HomeGroup

» Computers on a home network must belong to a workgroup, but they can
also belong to a HomeGroup. A HomeGroup makes it easy to share pictures,
music, videos, documents, and printers with other people on a home network.

* A HomeGroup is protected with a password, but you need to type the pass-
word only once, when adding your computer to the HomeGroup.

Domain

» One or more computers are servers. Network administrators use servers to
control the security and permissions for all computers on the domain. This
makes it easy to make changes because the changes are automatically made
to all computers. Domain users must provide a password or other credentials
each time they access the domain.
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« If you have a user account on the domain, you can log on to any computer
on the domain without needing an account on that computer.

* You probably can make only limited changes to a computer’s settings
because network administrators often want to ensure consistency among
computers.

e There can be thousands of computers in a domain.

e The computers can be on different local networks.

Windows-based computers on a network must be part of a workgroup or a
domain. Windows-based computers on home networks can also be part of a
HomeGroup, but it’s not required.

Computers on home networks are usually part of a workgroup and possibly a
HomeGroup, and computers on workplace networks are usually part of a domain.

The Network and Sharing Center

The Network and Sharing Center was first introduced in Vista and has been slightly
streamlined in Windows 7.

The main panel displays a compressed view of the network map, information about
existing network connections, and any resources the user can locate on the net-
work. You have links at the bottom of the center for the following:

e Set up a New Connection or Network: Set up a wireless, broadband, dial-
up, ad hoc, or VPN connection; or set up a router or access point.

e Connect to a Network: Connect or reconnect to a wireless, wired, dial-up or
VPN network connection.

e Choose Homegroup and Sharing Options: Access files and printers located
on other network computers, or change sharing settings.

» Troubleshoot Problems: Diagnose and repair network problems or get trou-
bleshooting information.

On the left side of the screen, you can click links to Manage Wireless Networks,
Change Adapter Settings, or Change Advanced Sharing Settings.

Of course, to connect on the network, you need to have installed a network
adapter. These come in several forms, including network cards, USB wireless net-
works, or integrated network adapters built into your laptop or desktop. Fortunate-
ly, most modern network adapters are plug and play and get you immediately con-
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nected to the network. But that might not be the case if you are upgrading to Win-
dows 7 with older hardware.

If you have upgraded and suddenly disconnected from your network, there is a
good chance your network drivers need to be updated. There are several ways to
do this; one of these is from the aforementioned Change Adapter Settings link.

Here's a little conundrum: Your network adapter needs drivers to be updated so
you can get on the Internet, but the only place to get these drivers is the Inter-
net. The workaround for this could be a little tricky. The best answer is to down-
load the drivers from another computer that can get on the Internet, then copy
them to a portable jump drive to install them on the computer that has the out-
dated drivers. The next question is, “What type of network adapter do | have?”
One way to find out is to look in Network Connections. Windows 7 might have
recognized your network card but just might not have drivers for it. If you know
you have a network adapter installed, you might have to consult with your com-
puter manufacturer or take apart your computer to see the brand and model of
your network card. If all this seems too difficult, buying an inexpensive plug-
and-play USB network adapter is a low priced alternative.

{g) LET ME TRY IT

Upgrade Your Network Adapter Driver

The following steps show you how to upgrade your network adapter drivers. Inter-
net access is recommended to complete this exercise.

Click the Start orb.

Click Control Panel.

Select Network and Internet.

Click Network and Sharing Center.

In the left pane, click Change Adapter Settings.

Point to the adapter you want to update, right-click, and select Properties.
If a UAC window opens, click Yes.

Click the Configure button.

Select the Driver tab.

Click Update Driver.

S © ® N o U & W NS
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If you have a disk or other location where you have updated network driv-
er software, select Browse My Computer for Driver Software.
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12. Type the location (or click Browse to locate the drivers) and click OK.
13. Click Next.

14. Windows searches the location for updated drivers. If it finds more than
one choice, it presents you with all options. Pick the closest one to your
specific hardware.

15. You might receive a notification that your drivers have not been digitally
signed. Read the message carefully before proceeding. In many cases, the
drivers will work. However, you will have to decide whether to use them
or not.

16. Upon successful completion and connection to the network, return to Net-
work Connections to see an icon for your new connection.

When updating drivers, your hardware manufacturer might not yet have
released drivers for Windows 7. If drivers for Vista are available, install those
instead. Oftentimes, drivers between the two systems are interchangeable. If
and when Windows 7 drivers for your hardware are released, they most likely
will be available as an optional download in Windows Update.

One newcomer to the Network and Sharing Center is View Your Active Networks,
which is located just below the basic network map. Here you will see all the net-
works you can connect to along with any to which you are currently connected.

Another nice touch is a refinement to the Connect to a Network dialog box. This is
the second link under the heading Change your Network Settings. Click this to
bring up a new pop-up box called the View Available Networks (VAN) interface.
This is similar to the Connect to a Network pop-up used to connect to networks in
Vista. A subtle revision here is the removal of one layer of display messages. The
menu pops up above the network icon and shows up like a jump menu.

When the pop-up appears, it not only shows you what network you are connected
to, but a Change button gives you one-click access to previously established con-
nections. This is a simple yet effective upgrade.
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Setting Up Your Network Location

You might have noticed each time you connect to a network a dialog box appears,
asking you to select your network location. This feature was first introduced in
Vista. The purpose of this dialog box is to automatically configure your firewall and
security settings depending on your location. Here are the four network locations
and an explanation for each one:

Home Network: There are two instances when you choose this setting. One
is for home networks and the other is when you know and trust the users and
devices on the network. Because computers on a home network can belong
to a HomeGroup, there is much greater access allowed to available network
resources. Network discovery is turned on for home networks, which allows
you to see other computers and devices on the network and allows other
network users to see your computer. This setting offers the easiest connectivi-
ty between computers and network devices.

Work Network: Select Work Network if the network you are connected to is a
small office or similar workplace network. You will be visible to other comput-
ers since network discovery (which allows you to see other computers and
devices on a network and allows other network users to see your computer)
is on by default. One restriction with this setting is that you cannot create or
join a HomeGroup.

Public Network: Choose Public Network for networks in public places (such
as cafés, airports, or networks offering free Wi-Fi). This setting keeps your
computer from being visible to other computers around you and is the most
restrictive in terms of security and visibility. Use this setting on a public net-
work to help protect your computer from any malicious software from the
Internet. You cannot connect to a HomeGroup is on public networks and net-
work discovery is turned off. Also consider using this option if you're connect-
ed directly to the Internet without using a router. A router serves as an addi-
tional layer of insulation from all Internet attacks. Without a router, your fire-
wall needs to be set to a highly secure state. Also use Public Network if you
have a mobile broadband connection. This also requires high security and
firewall protection.

Domain: If you see this setting, it is unchangeable and controlled by your
network administrator.

When connecting to a secured network, the only requirement now is to enter the
network security key (passphrase). If you are switching from Windows XP to Win-
dows 7, this is a welcome change because you no longer have to specify the
encryption type (WEP, WPA, or WPA2).
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Although it's not part of the network map, the network folder is closely related to
it. From here you can view all available network resources (see Figure 8.6). This can
be opened by clicking Network from any Explorer window, which shows the com-
puters and other resources you have access to on the network. A link back to the
Network and Sharing Center is on the top menu. Clicking on any of the computer
icons shows any shared resources on these devices you can share.
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Figure 8.6 Setting up a connection or network.
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Setting Up a New Broadband Connection to the Internet

To complete the following steps, you will need a broadband connection to the
Internet along with the ISP-assigned user name and password. Upon successful
completion, you will have established a high-speed connection to the Internet.

1.

2
3
4.
5

o

Click the Start orb.

Click Control Panel.

Click Network and Internet.

Select Network and Sharing Center.

Click Set up a New Connection or Network. This opens the Set Up a Con-
nection or Network dialog box.

Click Connect to the Internet.
Click Next.

You are asked, “How do you want to connect?”
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9. Select Broadband. The Connect to the Internet configuration screen
opens.

10. Type your User Name and Password.
11. Select Remember This Password.

12. Click Connect to establish your new connection.

Network printers were once a part of business networks exclusively, but low cost
and improved technology have made network printers an attractive option for
the home as well. Once installed on a wireless home network, users can print
from anywhere within the wireless network range. Very convenient!

5 SHOW ME Media 8.2—The Network and Sharing Center
Access this video file through your registered Web Edition at
my.safaribooksonline.com/9780768695212/media.

Connecting to a Printer Share from Another Computer

The following steps show you how to connect to another computer (with a printer
connected to it that is shared) and then access the shared printer. When you finish
this exercise, you will be able to print from the shared printer.

1. Click the Start orb.

2. Click Computer.

3. In the left pane, click Network.

4. In the top menu, click Add a Printer. The Add Printer dialog box appears.
5

Click Add a Network, Wireless or Bluetooth Printer and click Next. Windows
searches the network for available printers.

6. When it finds the network printer you want to connect to, select it and
click Next.

7. If a printer driver suitable for use with Windows 7 is available, the printer is
installed. If not, Windows uses Windows Update to search for a driver
online.

8. Upon successful installation of your printer drivers, your network printer is
now ready for use.
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Utilizing the Network Connectivity Status Indicator
(NCSI)

The NCSI (a feature we saw implemented originally in Vista) is the little networking
icon that sits in your Notification Area. It has four different states you can use to
quickly see if there is a connectivity problem.

It will either tell you No Connectivity where it has a little Red X, or “Connectivity
Problem” which has a little warning caution sign over it, or Local connectivity which
has only the computers, and then Internet Connectivity has the Globe on top of it
indicating that you have access to the Internet.

Another enhancement to this icon is the fact that if you have a notebook computer
and there is a network card built in and then also a wireless network card, you
would, in the past, have two network status icons. One of might appear broken all
the time because you don’t usually have both plugged in and available.

With Windows 7 (actually, starting with Vista), one of the benefits with the new
NCSl icon is the fact that it consolidates all your network connections to one icon.
So if there is something going on with two separate connections and you hover
over one connection, you'll see the two distinct network connections listed there
individually.

If your network is always on, you might not need the icon in the Notification Area.

Removing the Network Icon from the Notification
Area

The following steps show you how to remove the networking icon from the Notifi-
cation Area. Take note of the other modifications you can make in this window
while in this section.

1. Right-click the Start orb.

2. Select Properties.

3. Select the Taskbar tab.

4. In the Notification Area, click Customize.
5

Locate the Network icon, click the drop-down for Behaviors, and select
Hide Icon and Notifications.

6. Click OK.

The icon is removed from the Notification Area taskbar.
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The Network Map

At the top of the Network and Sharing Center, you might have noticed a mini-map
of your connection to the Internet with a connecting router shown between your
computer and the Internet. If you select the See Full Map option, you will see an
expanded display of your computer and everything your computer is connected to,
including any network connections (wired and wireless), any computer-to-comput-
er connections (called ad hoc), and any connections to the Internet (see Figure 8.7).
The map shows you any problems between connections as well, so you can begin
diagnosing connectivity issues visually before you make corrections physically.

Figure 8.7 The Network map indicating an Internet connectivity issue.

One little-known feature of the network map is the ability you have to click on a
problem area to start Windows onboard diagnostics. This was first introduced in
Vista and has been slightly revised and updated for Windows 7. For example, if you
see an X over the connection between your computer and the Internet, click the X
to diagnose the problem. This opens Windows diagnostics and attempts to solve
the problem for you.

Viewing the Network Map

The following steps show you how to view the Network Map in a few easy steps.
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Click the Start orb.

Click Control Panel.

Click Network and Internet.

Click Network and Sharing Center.

In the right corner, click See Full Map.

Windows creates and displays the Network Map.

The Network Map looks similar to the one in Vista but it functions a bit better
and seems to have an easier time locating devices on the network, even pre-
senting you with ones that it cannot integrate into the map. This helps in under-
standing the network topology.

Advanced Sharing Settings

Selecting Advanced Sharing Settings brings you to the options for different net-
work profiles. Here you can choose the Home or Work profile or the Public profile.
And then you can set the following options:

Network Discovery: When Network Discovery is on, this computer sees other
network computers and devices and it is visible to other network computers.

File and Printer Sharing: When File and Printer Sharing is on, files and print-
ers that you have shared from this computer can be accessed by users on the
network.

Public Folder Sharing: When Public Folder Sharing is on, users on the net-
work, including HomeGroup members, can access files in the Public folders.

Media Streaming: When Media Streaming is on, users and devices on the
network can access pictures, music, and videos on this computer. This com-
puter can also find media on the network.

File Sharing Connections: Windows 7 uses 128-bit encryption to help pro-
tect file-sharing connections. Some devices don’t support 128-bit encryption
and must use 40- or 56-bit encryption.

Password Protected Sharing: When Password Protected Sharing is on, only
a user who has a user account and a password on this computer can access
shared files, printers attached to this computer, and the Public folders. To give
other users access, you must turn off Password Protected Sharing.
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One distinct setting between Private and Public settings is the HomeGroup con-
nections setting (which you cannot use on the Public network side).

Media Streaming is one option that media lovers will get excited about. Enabling
this option allows you to turn your Windows 7 into a streaming media source for
your network. By default, this feature is turned on, but you can customize it here in
Advanced Sharing Settings. Click Choose Media Streaming Options to access these
options.

There are a ton of possibilities with this:

« Listen to music on your Windows 7 machine from another computer on the
other side of the house.

* View your videos on an Xbox 360 connected to the TV in a spare bedroom.

» Access your photo galleries stored on your Windows 7 machine on another
computer.

Parents who are concerned with what content can be accessed are welcome to
take control of this by clicking the Customize link. Here you can customize the con-
tent rating you will permit streamed to media programs and remote connections.

One other aspect of Media Streaming is that it runs independent of your file and
print sharing security configuration. That means you can enable media streaming
to multiple devices on the network without easing up the file and print sharing
setup you have on the same machine.

Troubleshoot Problems

When you click the Troubleshoot Problems link off the Network and Sharing Center,
this tool initially searches for troubleshooting packs and then presents them to you
for both network and Internet options.

Accessing the Troubleshooting Packs

The new Troubleshooting packs in Windows 7 are easy to locate and use (see
Figure 8.8). The following steps show you how to find them.

1. Click the Start orb.
2. Click Control Panel.

3. Click Network and Internet (unless you have icons showing in Control
Panel, in which case you can simply click the Troubleshoot link).
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Figure 8.8 Troubleshooting packs.

4. Click Network and Sharing Center.
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5. Click the Troubleshoot Problems link, which opens the troubleshooting pack.

Selecting anyone of the options provided opens a troubleshooting tool that is

designed to specifically detect problems related to your choice. The benefit here is

that you no longer need to search for every type of problem in the universe if

your connection is giving you trouble—especially if you know that the problem is
coming from the network adapter specifically or the Internet side of your network

connection.

The network diagnostics automatically run a set of troubleshooting tools that ana-

lyzes all elements of the network or Internet item you've chosen and provides a

systematic diagnosis of connectivity problems. It then automatically resolves the
problems it finds or at least will walk you through simple solutions.

Accessing the Internet Connections

Troubleshooting Pack

Complete the following steps to access a simple troubleshooting wizard that looks
at your Internet connectivity and tries to locate any issues. If it can’t find a problem,

the troubleshooter takes you to Windows Help and Support for further analysis.
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Click the Start orb.

Click Control Panel.

Click Network and Internet.

Choose Network and Sharing Center.

Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.

Click the Internet Connections button, which opens the Troubleshooting
pack for Internet Connections.

Click Next. The wizard then attempts to diagnose potential problems.

Click Troubleshoot My Connection to the Internet. It then checks for
problems in web connectivity, name resolution, and network gateway
configuration.

If the troubleshooter can’t solve the problem automatically, you are pre-
sented with the most likely problem and a series of steps to correct it.

If this still does not solve your problem, click the Why Can’t | Connect to the
Internet link to open Windows 7 Help and Support. You can review additional
solutions to your problem there.

Accessing the Shared Folders Troubleshooting Pack

Complete the following steps to access a simple wizard that looks at the shared
folders you are trying to connect to and fixes any issues connecting to them. If it
can't find a problem, the troubleshooter takes you to Windows Help and Support
for further analysis.

1.

2
3
4.
5

Click the Start orb.

Click Control Panel.

Click Network and Internet.

Choose Network and Sharing Center.

Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.

Click the Shared Folders button, which opens the Troubleshooting pack for
Shared Folders.

Click Next.
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Using the following sample format, type the network location you would
like to access in this format: \\MarketingPC\Resources\Data.

Click Next. The wizard attempts to detect name resolution and network
gateway configuration problems.

If the troubleshooter can’t solve the problem automatically, you are pre-
sented with the most likely problem and a series of steps to correct it.

If this still does not solve your problem, click the link Why Can’t | Connect
to the Internet link to open Windows 7 Help and Support.

You can review additional solutions to your problem there.

Accessing the HomeGroup Troubleshooting Pack

Complete the following steps to access a simple troubleshooting wizard that looks
at your HomeGroup and tries to locate issues connecting to it. Follow the trou-
bleshooting instructions to locate and resolve issues.

1.

2
3
4.
5

10.

Click the Start orb.

Click Control Panel.

Click Network and Internet.

Choose Network and Sharing Center.

Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.

Click the HomeGroup button, which opens the Troubleshooting pack for
HomeGroup.

The UAC window might appear. If so, click Yes.
Click Next. The HomeGroup diagnostics begin.
Different messages will display, depending on your issue.

If the diagnostics apply a solution, you are asked if the problem is fixed.
Select the appropriate answer to proceed.
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Accessing the Network Adapter Troubleshooting
Pack

Complete the following steps to access simple wizard that looks at your network
adapter and tries to locate any issues. If the troubleshooter can't resolve the issue,
it takes you to other options for solving the problem.

1. Click the Start orb.
Click Control Panel.

2

3. Click Network and Internet.

4, Choose Network and Sharing Center.
5

Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.

6. Click the Network Adapter button, which opens the Troubleshooting pack
for Network Adapter.

7. Click Next.

The troubleshooter attempts to solve the problem and presents a possible solu-
tion. If it is unable to locate a problem, you will are presented with an opportunity
to explore additional options or close the troubleshooter.

Accessing the Incoming Connections
Troubleshooting Pack

Complete the following steps to access a simple wizard that looks at your incoming
connections and tries to locate any issues. If the troubleshooter can't resolve the
issue, it takes you to other options for solving the problem.

1. Click the Start orb.

2. Click Control Panel.

3. Click Network and Internet.

4, Choose Network and Sharing Center.
5

Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.

6. Click the Incoming Connections button, which opens the Troubleshooting
pack for Incoming Connections.
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Click Next.

Select from one of the four choices:

* Share Files or Folders

 Connect to this Computer Using Remote Desktop Connection
¢ Find this Computer on the network

» Something Else

Click Next.

A series of diagnostics runs, attempting to solve the problem. You are pre-
sented with the results.

Accessing the Connection to a Workplace Using
DirectAccess Troubleshooting Pack

Complete the following steps to access a simple wizard that looks at your Direct
Access configuration and tries to locate any issues. If the troubleshooter can't
reslove the issue, it takes you to other options for solving the problem.

1.

2
3
4.
5

10.

11.

Click the Start orb.

Click Control Panel.

Click Network and Internet.

Choose Network and Sharing Center.

Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.

Click the Connection to a Workplace Using DirectAccess button, which
opens the Troubleshooting pack for Connection to a Workplace Using
DirectAccess.

Click Next.
Read the DirectAccess compatibility requirements.
Click Next.

Connection to a Workplace Using DirectAccess diagnostics attempts to
locate and solve the problem automatically. The results are displayed.

The results display.
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Accessing the Printer Troubleshooting Pack

Complete the following steps to access a simple wizard that looks at your printer
and tries to locate any issues. If the troubleshooter can't resolve the issue, it takes
you to other options for solving the problem.

1. Click the Start orb.

2. Click Control Panel.
3. Click Network and Internet.
4, Choose Network and Sharing Center.
5. Click the Troubleshoot Problems link, which opens the Troubleshooting
pack.
6. Click the Printer button, which opens the Troubleshooting pack for Printer.
7. Click Next.
8. Diagnostics assess your printer situation.
9. Select the printer you would like to troubleshoot.
10. Click Next.

11. The troubleshooter diagnoses any problems and presents possible solutions.

Configuring Your TCP/IP Settings

There is a certain form of standardization in the networking world that allows our
hardware to communicate with machines all over the world. Transmission Configu-
ration Protocol/Internet Protocol (otherwise known as TCP/IP) serves as the prime
communication language for our computers.

TCP/IP has evolved over the years. Windows 7 supports the latest version, IPv6.
While this version supports more IP addresses than IPv4, the fundamentals of the
IP stack have not changed. That’s great news because that means there is little or
no need for users to manually configure IP settings. For the vast majority of home
users, changing TCP/IP settings is rarely—if ever—done.

Because you almost never have to configure TCP/IP settings these days, you might
have forgotten some of the basics about them. In Windows 7, you access these set-
tings in the Local Area Connection Properties dialog box (see Figure 8.9).
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Figure 8.9 The Local Area Connection Properties dialog box.

Opening Local Area Connection Properties

Follow these steps to see the settings for all the network adapters connected and

recognized by the sytem.

1.

Click the Start orb.

Click Control Panel.

In the Network and Internet group, click the View Network Status and
Tasks link.

In the left pane, select Change Adapter Settings.

From an active network connection, right-click and choose Properties. (If a

UAC window opens, click Yes.) This brings up the Local Area Connection Prop-
erties dialog box.

191
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Dynamic Host Configuration Protocol (DHCP) is a critical part of most modern
networks. Simply put, DHCP allows a computer (typically a server) or router
(such as a wireless network router) to handle all the heavy lifting when it comes
to creating and maintaining the network. A DHCP server provides the TCP/IP
address to host devices on the network. The address is supplied in octet form
(such as 192.168.0.1) and provided to devices on the network. Once DHCP is
established and address are assigned, the network operates pretty much on its
own. Windows 7 is set up out of the box to run in a DHCP environment.

There are occasions when some computers or devices might require what is
called a static IP. This is a fixed address that never changes. This might be a
requirement, for example, when connecting to certain network printers or
copiers. Or port forwarding might be required on a certain machine. By and large
however, static IP addresses are seldom seen in mainstream home networks.

If you are asked to configure your TCP/IP settings, it's a good idea to know what
your settings are. Then, if you have some trouble, you can restore those settings. A
quick way to see your IP settings is to use the command prompt.

Checking Your TCP/IP Settings from a Command
Prompt

Upon completing these steps, you will be able to see the TCP/IP settings for all net-
work adapter on your computer. This exercise accesses these settings through the
command prompt.

1. Click the Start orb.

2. In the search field, type ecmd and then press Enter. A black screen opens to
a command prompt.

Type ipconfig and press Enter.

4. Locate the IP address for your active network connection.

When working from a command prompt, you should be able to see the version of
your IP address. (If not, you might need to scroll up on the command window to view
all the IP information.) It might be an IPv4 address. The number appears in octet form
(such as 192.168.0.3). You also have listed here the subnet, default gateway, and DNS
information. This data is required if you ever need to establish a static IP.

The command prompt is another fast way to test your Internet connection when you
have connectivity problems. For example, simply type ping www.google.com to send a
ping request to Google. If it succeeds, you receive a reply with a status of the packet
speed. If it fails, you receive a failure message, such as Ping Request Could Not Find Host.
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The command prompt used to be a crucial part of Windows. With each succes-
sive version, as more and more elements have become parts of the graphical
interface, | tend to use the command prompt less and less.

If you need to change your TCP/IP address, first determine the type of address you
have (IPv4, IPv6, or both). Once you know that, you can configure your new address.

53 SHOW ME Media 8.3—Configure Your TCP/IP Settings
Access this video file through your registered Web Edition at
my.safaribooksonline.com/9780768695212/media.

Changing a Network Adapter to Use a Static IPv4
Address

This exercise shows you how to change your IP settings from DHCP to static and
how to insert an IPv4 address into your network adapter settings (see Figure 8.10).
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Figure 8.10 Configuring a static IP address.

Click the Start orb.

Click Control Panel.

In the Network and Internet group, click the View Network Status and Tasks link.
In the left pane, click Change Adapter Settings.

Lol
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5. From an active network connection, right-click and choose Properties. (If a
UAC window opens, click Yes.) The Local Area Connection Properties dia-
log box appears.

6. Click the correct Internet Protocol Version and click Properties. The Inter-
net Protocol Version Properties dialog box appears.

7. Use the Following IPvX Address radio button.

8. Inthe IPvX Address box, type the new IP address.

9. Complete the information for Subnet Prefix Length box and the Default
Gateway box, respectively.

10. Complete the information for the Preferred DNS Server box.

11. Click OK.

Today, routers are inexpensive and usually easily obtained. But a situation could
arise where there is no router available. What if you find yourself in a situation in
which you have several computers, but only one connected to the Internet? Does
Windows 7 provide a way to connect them all to the Internet? Yes, there is: it's
called Internet Connection Sharing (ICS). ICS is not used frequently, but it is good
to know about it in case the need arises. The minimum hardware you will need to
make it work is a computer connected to the Internet (host) and a wired hub. Be
sure the host can connect to both the Internet and the wired hub simultaneously.

| set up an ICS environment without a wired hub by using a wireless router. To
do this, | had to dumb down the router and turn off DHCP. This turned it into a
simple router. After plugging in the ports to local computers, | used the ICS host
to set up the network. Not the best solution, but better than nothing.

‘g) LET METRY IT

Setting Up Internet Connection Sharing on a Wired
Network

The following steps show you how to set up ICS. Upon completion, computers on
your network can access the Internet through the local system.

1. On the host computer with a connection to the Internet, click the Start orb.
2. Click Control Panel.

3. Choose Network and Internet.

4

In the Network and Sharing Center, click View Network Status and Tasks.
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10.
11.
12.

13.
14.

Configuring Your TCP/IP Settings

In the left pane, click Change Adapter Settings.

Right-click the connection to the Internet and choose Properties. If it's a
Local Area Connection, the Local Area Connection Properties dialog box
appears.

Click the Sharing tab. (You won't see this tab if you have only one network
connection.)

Select the Allow Other Network Users to Connect Through This Comput-
er’s Internet Connection check box.

Click OK.

Verify your Internet connection is operating correctly.

195

Connect the first computer you want to share the Internet with to the hub.

Make sure the newly connected computer is set to receive IP addresses
automatically.

Test the connection to the Internet.

Add additional computers sharing the Internet in the same way.

A no-no when using ICS: Do not use ICS on networks that have DHCP servers, DNS
servers, domain controllers, or gateways. Remember, your wireless router likely is
also your DHCP server, so make sure you are disconnected from it before setting
up ICS. Having these up on the network at the same time creates conflicts and
brings your network to a grinding halt.

@ TELL ME MORE Media 8.4—A Discussion of the Ease of

Networking with Windows 7
Access this audio recording through your registered Web Edition at
my.safaribooksonline.com/9780768695212/media.
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Removing Unnecessary Files and
Programs

Having Windows 7 your way also means that you get to decide
which files and programs you store on your computer’s hard disk
drive. That'’s important, because bad things can happen if your
hard disk gets too full. Not only do you run out of space to store
new stuff, but it also affects your computer’s performance; a too-full
hard drive slows down your PC.

So it’s important that you learn how to remove the stuff you don’t
use or need from your hard drive. That’s what this chapter is about.

Hard Disk Capacity—Enough Is Never Enough

It always seems like you have more than enough space on your
hard disk—when you first get it. Back in the mid-1980s, we mar-
veled at the huge 10MB (that’s megabytes—not gigabytes) of storage
available on early IBM PCs. In 1991, we wondered how we would
ever fill the 100MB of capacity on that era’s newest drives. By the
year 2000, those older drives appeared tiny next to the first 1GB
drives. In 2005, 500GB seemed like it would hold a lifetime of data.
And today, in mid-2009, the latest 1TB (that’s one terabyte—or one
million megabytes) drives look to be big enough to hold entire col-
lections of digital photos and music, with plenty of room to spare.

But here’s the deal. Over time, even the largest hard drives get
smaller—at least in perception. That'’s because when the space is
available, we fill it. As the weeks and the months and the years go
by after you purchase a new PC, you install lots of new programs
and create tons of data files—letters, memos, email messages,
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digital photographs, music tracks, videos, you name it. And all this stuff
fills up even the largest hard drive.

There’s more to it, of course. The fuller your hard drive gets, the slower
your computer runs. Oh, the sluggishness comes gradually, maybe you
don’t even notice it for the first year or so, but every new item that takes
up space on your hard disk works to eventually slow down your system to
the point that the performance change becomes noticeable. There is a
direct correlation between the amount of “stuff” on your hard disk and
how fast your system performs.

But why is this? Why does installing more programs and creating more
files slow down your computer? And what can you do about it, after the
fact?

Why a Crowded Hard Disk Slows Down Your System

Here’s the rule: The more unused hard disk space your computer has, the
faster it will run. There are a number of reasons for this.

First, your computer sometimes uses your hard disk as a kind of backstop
when system memory fills up. In this instance, your hard disk serves as
virtual memory, temporarily storing programs and data just as your sys-
tem’s random access memory (RAM) normally does. This facilitates file
swapping, where program and data files are swapped between random
access memory (for immediate access) and virtual hard disk memory (for
not-quite-immediate access).

If there’s a lot of free hard disk space, that means there’s lots of virtual
memory available for this file swapping, which lets your system run
quickly. If there’s not a lot of free hard disk space, that means less data
can be loaded into this virtual memory—and the less stuff loaded into
memory, the slower your system runs. It’s a simple equation: Free up hard
disk space for virtual memory and speed up your system.

But memory, virtual or otherwise, isn’t the only thing that affects your
system’s performance. Every time you open or save a program or docu-
ment, that program or document file has to be read from or written to
your computer’s hard disk; that’s basic computer operation. If you only
have a few files on your hard disk, it's relatively easy for your computer to
find the right file to read or write to, which makes for speedy operation.
The more files you have on your hard disk, however, the more files your
computer has to sort through to find the right one to read or write to,
which slows down your computer’s performance. In other words, the more
things stored on your hard drive, the longer it takes to access any one
thing.
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How Much Free Space Do You Need?

So if you want to speed up your system, you need to delete all but the
most essential programs and files, and leave plenty of spare hard disk
space for potential use as virtual memory and other hard disk chores. But
how much free hard disk space do you need?

I recommend keeping at least 20% of your hard disk free; this should
leave plenty of room for virtual memory, file swapping, temporary file
storage, and the like. For example, if you have a 500GB hard drive, you
want to utilize no more than 80% of the available space, leaving at least
100GB of free disk space at any given time. Do the math to figure out
how much free space you need on your particular hard drive.

What's on Your Hard Disk—And Why?

When it comes to managing hard disk space your way, it helps to know
just what kinds of files you have stored on your hard drive. Which files
are essential—and which are expendable?

Understanding Computer Files

While every user’s hard drive is different, you can normally organize your
files into the following five major categories:

e System files. These are files used by the Windows operating system,
and should not be deleted. (If you do delete them, Windows will
probably crash.) These include executable files (typically with a .DLL
or .SYS extension), device drivers (.DRV extension), configuration
files (.INI extension), and the like.

e Program files. These are the files used by the software programs
installed on your system, typically with an .EXE file extension.
Obviously, files for programs you don’t use can be deleted from your
hard disk; programs you do use should not be deleted.

¢ Data files. These are the documents, spreadsheets, presentations,
music tracks, videos, digital photographs, and the like you create
and run with your software programs, or download off the Internet.
You may find it better for system performance if you don’t archive
all your older data files on your main hard drive. Files you don'’t
access frequently can be stored on external hard drives, CDs, or
DVDs.

e Temporary files. These are files stored in a special “cache” on your
hard drive. These may be web pages downloaded by your web
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browser and cached for quick viewing, or data files opened and tem-
porarily stored by the host application. Temporary files are typically
created when data used by a program is larger than the available
memory space. Most temporary files are automatically deleted when
the host application is closed, but sometimes, due to a program
crash or ill-behaved application, they’re not deleted—and continue
to take up valuable hard disk space. Most temporary files have a
.IMP extension and can be safely deleted.

e Deleted files. Here’s one that might surprise you. Files that you
delete from your hard drive actually aren’t immediately deleted.
Instead, they’'re moved to the Recycle Bin, a special folder that holds
“deleted” files in case you want to undelete them in the immediate
future. By default, Windows 7 allocates to the Recycle Bin 4GB plus
5% of your hard disk space—which can be a lot when you have a
really big hard drive. You can, however, change the amount of space
allocated, and “empty” the Recycle Bin to free up hard disk space.

To summarize, system files should not be deleted (ever), program and
data files can be deleted if you don’t need them, and temporary and
deleted files can always be deleted.

Understanding Bundleware

There’s a special category of program files that should be addressed. I'm
talking about bundleware, those programs that come preinstalled when
you purchase a new PC. More often than not, these are not programs you
want on your new PC, which is why some wits (including some Microsoft
managers) describe these programs as crapware or craplets.

As you can tell by the nickname, most folks hate this stuff. Users hate
having their brand-new desktops cluttered with this crap, and technicians
hate having to clean it off users’ sluggish PCs. It’s just not popular.

About the only folks who like bundleware are the hardware manufactur-
ers. That’s because they get paid by each company to install its software
in this fashion. Given the slim margins inherent in computer manufactur-
ing, the pennies that various software companies pay per machine to pre-
load their bundleware can be the difference between profit and loss for
the hardware manufacturer.

What kind of programs are we talking about? It's all the stuff you find
cluttering the desktop and Start menu of a new PC. This might include
sign-up utilities for one or two Internet service providers, icons for a cou-
ple of online music services, a handful of instant messaging clients, some
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cheapo games, a web browser toolbar or two, an anti-virus program that
expires in 90 days or so, maybe even trial versions of Quicken or Adobe
Photoshop Elements. Depending on the price of the PC, you might also
get a functioning version of Microsoft Works or a 90-day trial version of
Microsoft Office. All in all, expect at least 10% of your new PC’s hard disk
space to be taken up with these unwanted programs.

tip

Some retailers, such as Best Buy, offer to remove all the bundleware from a new
PC you purchase—for a price. Depending on the price, this may not be a bad
thing, as some retailers also install any necessary operating system updates,
drivers, and the like at the same time.

And here’s the really annoying thing: Much bundleware isn’t even fully
functioning software. More often than not what you get is a “trial” ver-
sion that only works for a set period of time (30 or 90 days), or one that is
somehow crippled in functionality. If you want to use the full version of
the program, you have to purchase it separately. The bundleware version
is just a tease or advertisement.

Even more annoying is the fact that if you don’t want the bundleware
taking up valuable hard disk space (or, even worse, preloading itself into
system memory), you have to manually uninstall the stuff. And, not sur-
prisingly, some bundleware makes itself quite difficult to uninstall. It's
unwanted stuff that’s hard to get rid of—and it slows down your PC, to
boot.

tip

Because bundleware is so time-consuming and difficult to remove, the first
thing many techie users do when they purchase a new PC is wipe off the hard
disk (thus deleting all the bundleware) and reinstall Windows from scratch. This
lets them start with a completely clean machine. (Although this doesn’t work if
you use the manufacturer’s “restore” CD/DVD—which typically includes all the
bundleware you're trying to get rid of!)

Freeing Up Hard Disk Space by Deleting
Bundleware

You're probably coming to the conclusion that you have a lot of stuff on
your hard disk that you just don’t need and is probably slowing down
your system. This is even true with a brand new PC, thanks to the prob-
lem of bundleware.
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What's the best way to get rid of these unwanted trial programs? One
approach is to use a utility dedicated solely to identifying and deleting
this so-called crapware. One such program is PC Decrapifier, which you
can download for free from www.pcdecrapifier.com.

Figure 23.1 shows PC Decrapifier at work. When you start it up, it scans
your system for potential crapware and lists them for you. Check those
you want to delete and click the Next button. PC Decrapifier does the
dirty work of uninstalling these nuisance programs so that you don’t have
to deal with them.
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FIGURE 23.1

Removing unwanted bundleware with PC Decrapifier.

tip

If you're not sure whether you want to use a program or not, don't let PC
Decrapifier delete it. Wait a few days or weeks, then if you haven't used the pro-
gram, you can rerun PC Decrapifier to delete it then.

Deleting Unwanted Files with the Disk Cleanup
Utility

PC Decrapifier only deletes programs it identifies as bundleware or trial
versions. You may also want to delete other types of files, which you can
do with the Windows Disk Cleanup utility. You use Disk Cleanup to auto-
matically free up extra hard disk space—and speed up your PC'’s perform-
ance.
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To use Disk Cleanup, follow these steps:

1. Click the Start button, and then select All Programs, Accessories,
System Tools, Disk Cleanup.

If prompted, select the drive or user files you want to clean up.

Disk Cleanup now analyzes the contents of your hard disk drive and
presents its results in the Disk Cleanup dialog box, shown in Figure
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FIGURE 23.2

Use Disk Cleanup to delete unused files from your hard disk.

4. You now have the option of permanently deleting various types of
files: downloaded program files, temporary Internet files, offline web
pages, deleted files in the Recycle Bin, and so forth. Select which files
you want to delete.

5. Click OK to begin deleting.

You can safely have Disk Cleanup delete all the listed files except for the
setup log, content indexer, and Office setup files, which are often needed
by the Windows operating system.
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tip

Of course, you can always delete unwanted files manually. You do this by open-
ing Windows Explorer, navigating to the files you want to delete, and then press-
ing the Del key on your keyboard.This moves the selected files to the Recycle
Bin, so don't forget to empty the Recycle Bin to formally free up that disk space.

Emptying the Recycle Bin

As noted previously, Windows allocates 5% or so of your hard disk space
to holding deleted files in the Recycle Bin. When you’ve deleted enough
files to exceed this limit, the oldest files in the Recycle Bin are automati-
cally and permanently deleted from your hard disk. That doesn’t help you
if you need an extra 10GB to 20GB of free disk space, however. In this
instance, you'll want to manually empty the Recycle Bin to thus free up
some of that valuable hard disk space.

To empty the Recycle Bin, all you have to do is double-click the Recycle
Bin icon on your desktop. Doing so opens the Recycle Bin folder, shown in
Figure 23.3. Now click the Empty the Recycle Bin button. When the Delete
Multiple Items dialog box appears, click Yes to completely erase the files.
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FIGURE 23.3

Emptying the contents of the Recycle Bin.
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tip

If you accidentally move a file to the Recycle Bin, you can restore it to its original
location by opening the Recycle Bin, selecting the file, and then clicking Restore
This Item.

Archiving Little-Used Files

To help free up space on your main hard drive, you may want to move
some of your data files to another storage device—an external hard drive,
USB flash drive, CD-ROM, or data DVD. This type of archiving is some-
thing my wife does every year with her digital photos. Each January, she
copies the previous year’s photos to a series of data CDs, and then stores
them in a secure location. The photos are there (on CD) if she needs to
access them, but they’re not taking up valuable hard disk space on her
PC.

This process is as simple as inserting or attaching the backup device or
medium, opening Windows Explorer, and then moving the selected files
to the backup medium. This can be done using cut and paste, the
Windows Move command, or by copying the files and then deleting them
from their old locations. In any case, you end up with the selected files on
the external device or disc, and lots of space freed up on your main hard
disk.

Uninstalling Unwanted Programs

Deleting old or unwanted data files frees up a good deal of hard drive
space. But if you want to make a big impact fast, you need to delete some
program files, too.

If you have one or more programs that you no longer want or use, you
can free up valuable hard disk space by uninstalling those programs from
your system. Here’s how to do it:

note

Some programs might require you to insert the original installation disks or CD
to perform the uninstall.
Open the Control Panel and select Programs and Features.

2. Windows now displays a list of installed programs, as shown in
Figure 23.4. Select the program you want to uninstall from this list.

3. C(lick the Uninstall button.
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4. If prompted, confirm that you want to continue to uninstall the
application. Answer any other prompts that appear onscreen; then
the uninstall process will start.

FIGURE 23.4

Deleting a program from your system.

cautioin

In some instances, the add/remove utility may not be able to completely
remove all aspects of a program. If you get an error message at the end of the
uninstall process, you may need to manually delete any files remaining in the
program folder on your hard drive.

The Bottom Line

It pays to keep your hard disk clean. This means getting rid of files and
programs that you no longer use or need. The more free hard disk space
you have, the more space you have to store newer stuff—and the faster
your system will run.
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EDITING THE REGISTRY
What Is the Registry?

The Windows Registry is a database in which Windows and application
programs store all manner of configuration settings, startup information,
hardware settings, user preferences, file locations, license and registra-
tion information, last-viewed file lists, and so on. In addition, the
Registry stores the associations between file types and the applications
that use them. For example, the Registry holds the information that tells
Windows to use Media Player when you click on an MPG movie file. In
the early days of DOS and
Windows, programs stored this .
ndows, programs W tip

kind of information in a random . .

. ) If you’re already familiar with the
collection of hundreds of files . . .

Registry, you might want to skip

scattered all over your hard ahead to the section “New Registry
disk. Thankfully, those days are Features.”
only a dim memory.

How the Registry Is Organized

The Registry is organized a lot like the files and folders on a hard disk.
Just as a hard disk can contain partitions, the Registry contains sepa-
rate sections called top-level keys. In each section is a list of named
entries, called keys, which correspond to the folders on a hard disk. And
just as a folder can contain files and more nested folders, a Registry key
can contain values, which hold information such as numbers or text
strings, and more nested keys. Even the way that file folders and
Registry keys are described is similar: a folder might be named
\Users\brian\chapter28, and a Registry key might be named
\HKEY_CURRENT_USER\Software\Microsoft.
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The two main “top-level” keys are as follows:

B HKEY_LOCAL_MACHINE contains all the hardware and machine-specific setup information for
your computer.

B HKEY_USERS contains a key for each user account created on the computer, including the
accounts used only internally by Windows services.

The keys under HKEY_USERS are mostly named using long numeric strings that are the user
account’s Security Identifier (SID) number. Usually, not all accounts’ keys are visible at the same
time. Each account’s key is loaded into the Registry when the user logs on and is unloaded a
short time after the user logs out. Each user’s key contains his or her personal Windows and
application settings and preferences.

The Registry Editor displays three other sections that look like they are separate top-level keys but
that are actually views of information inside HKEY LOCAL_MACHINE or HKEY_ USERS:

B HKEY CURRENT_USER is a shortcut to the subsection of HKEY USERS that corresponds to the cur-
rently logged-on user. That is, when you run the Registry Editor, HKEY CURRENT_USER shows
your Windows and application preferences and settings.

B HKEY_CURRENT_CONFIG is a shortcut to HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Hardware Profiles\Current and contains hardware and device settings specific to the hard-
ware profile used when Windows was started.

B HKEY CLASSES ROOT stores file associations, the information that Windows uses to link file
types to applications, and a huge amount of setup information for Windows software compo-
nents. It's actually a combined view of the contents of two other Registry sections:

HKEY LOCAL_MACHINE\Software\Classes, which holds settings that are made for all users,
and HKEY_CURRENT_USER\Software\Classes, which holds personal settings made just by the
current user. If the same value is defined in both HKEY CURRENT_USER\ ... and

HKEY LOCAL_MACHINE\.. ., the HKEY_ CURRENT_USER value is used.

New Registry Features

Windows Vista introduced some new features to the Registry: virtualization and 64/32-bit reflec-
tion. These features are also present, although somewhat changed in Windows 7, and this section
gives you a brief tour. The features are called Registry virtualization, redirection and reflection. This
topic is pretty gnarly and obscure, so on your first read, you might want to skip ahead to the sec-
tion titled “Backing Up and Restoring the Registry.”

Registry Virtualization

On Windows 7 and Vista, if an older application attempts to store information to HKEY LOCAL__
MACHINE\Software\xxx\yyy but doesn’'t have permission to change that key, the information will
actually be stored in HKEY_CURRENT_USER\Software\CLASSES\VirtualStore\MACHINE\
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Software\xxx\yyy. This is called Registry virtualization. Applications that the user runs will still
“see” the information as if it was in the intended location. As a result, applications that aren’t
aware of the new, tighter restrictions on HKEY_ LOCAL_MACHINE will run without a hitch, although
their settings will be per-user instead of machinewide.

You need to know this so you can check the alternative locations when you're investigating prob-
lems with Registry settings in your system.

If you change an application program’s preference setting that should apply to all users of the pro-
gram, but it affects only you, and the setting isn't changed when other users run the application,
most likely the configuration setting is stored in a Registry key under HKEY_ LOCAL_MACHINE that
isn’t writeable by you. When you make the change, Windows virtualizes the Registry value, and
only your account sees the change.

To fix this, first try to contact the software manufacturer for a workaround. If none exists, try this:

1. Locate the Registry key in which the setting is being saved. Either search the Registry for the
setting value or use a Registry change-monitoring tool such as Registrar Registry Manager, or
procmon from sysinternals.com, to see where the application saves your setting.

2. As an Administrator, locate the key in the left pane of the Registry Editor, right-click it, and
select Permissions. Select the Users entry and check Full Control.

3. Using your account, locate the virtualized copy of the key under HKEY_CLASES_ROOT\
VirtualStore and delete it.

4. Run the application and change the setting again.

After this, everyone should share the same copy of the setting.

Virtualization doesn’t occur under some circumstances. In those cases, the application simply is
allowed to fail in its attempt to make changes to HKEY_LOCAL_MACHINE. These circumstances are
listed here:

B If User Account Control is disabled.

B If virtualization is disabled by your network administrator, using Group Policy on a Windows
domain network.

B If the application is a 64-bit application.

B If the application program has a manifest, a block of data inside the application or in a separate
file that describes advanced security settings. Almost all the applications that come with
Windows—including Notepad; the command-prompt interpreter, cmd.exe; and the Registry
Editor—have manifests, so almost all Windows utilities do not see virtualized Registry settings.

B If a key is marked with a special flag that indicates that it is not to be redirected.
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run is marked this
way so that a virus that attempts to set itself up to run at logon via this key won't be capable of
doing so. The command-line utility REG can modify the virtualization flag. Type REG FLAGS /?
at the command-line prompt for more information.

28
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Virtualization is seen as a stopgap measure and will be unnecessary when most applications either
store information in HKEY_CURRENT_USER or explicitly set less restrictive permissions on their keys
in HKEY_LOCAL_MACHINE when they're installed.

Registry Redirection and Reflection

The 64-bit versions of Windows support running 32-bit Windows applications. This presents a prob-
lem because many Windows subcomponents are present in both 32- and 64-bit versions, and infor-
mation about them (such as program filenames) is stored in the Registry under keys whose names
were determined before Microsoft considered the need to distinguish between the two flavors. To
manage this, Windows stores information for 32-bit compo-

nents in an alternate location and feeds the stored informa- u n Ot e

tion to 32-bit applications when they ask for values from the
original location. This is called Registry redirection. The infor-
mation for 32-bit applications is actually redirected to
HKEY_LOCAL_MACHINE\Software\WOW6432Node. When a 32-

You must close the 64-bit version of
the Registry Editor before you can
open the 32-bit version, and vice
versa, unless you start the second

bit application requests information from a redirected key instance of the Registry Editor with
using the original location, it is fed information from below the -m command-line argument.
WOW6432Node.

When working with the Registry on a 64-bit system, you need to know to look under WOW6432Node
when looking for setup information for 32-bit components.

Alternatively, you can use the 32-bit version of regedit; this presents all information in the stan-
dard locations seen by 32-bit applications. When you run regedit from the command line, you get
the 64-bit version. However, if you run %systemroot%\syswow64\regedit.exe, you get the 32-bit
version and can edit the values seen by 32-bit applications.

So that the 32-bit and 64-bit versions of components and applications can communicate, some set-
tings and values that these components store in the registry are copied to both locations. This is
called Registry reflection.

Reflection was used in several sections of the Registry in Windows Vista, but in Windows 7, only
two keys are subject to reflection:

HKEY_LOCAL_MACHINE\Software\Classes\CLSID
HKEY_LOCAL_MACHINE\Software\Classes\Interface

For more information on reflection, see Microsoft Knowledge Base article 305097 at http://sup-
port.microsoft.com/kb/305097. Also, search msdn.microsoft.com for the article titled “Removal of
Windows Registry Reflection.”

Backing Up and Restoring the Registry

Because the Registry is now the one place where all the Windows hardware and software settings
are stored, it's also the one thing that Windows absolutely needs to run. If you have to use the
Registry Editor to manually change Registry settings, we strongly suggest that you back up your
Registry before you make any changes.
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Backing Up the Registry

You can back up the Registry several ways. In order of preference, these are using a third-party
Registry-backup program, backing up the entire hard disk using a third-party program or Complete
PC Backup, using System Restore, and using the Registry Editor to save a key to a text file.

I suggest that you use a third-party disk-backup solution to back up the Registry files every time
you back up your hard disk. Before you install a piece of new hardware or a significant software
package, do a full disk backup, including the Registry. Before you manually edit the Registry for

other purposes, back up the Registry by any of the means discussed in the next few sections.

Backing Up with Third-Party Registry-Backup Software

There are third-party programs specifically designed to back up and restore the Registry. For exam-
ple, SuperWin's WinRescue program (www.superwin.com) not only can back up and restore the
Registry, but also can defragment the Registry’s files and work magic to revive a nonbootable
Windows system. (There is a version called WinRescue Vista that you should use if no Windows
7—specific version has been released.) There is also a free tool called ERUNT, which you can down-

load from www.larshederer.homepage.t-online.de/erunt.

These programs come with instructions on backing up, restoring, repairing, and maintaining the

Registry.

Backing Up the Hard Disk

You can save the Registry by performing a backup of the entire
contents of the hard disk on which Windows resides. On the
Windows 7 Home versions, you'll have to use a third-party disk
backup program to back up the entire hard disk. On Windows 7
Professional, Enterprise, and Ultimate editions, the Complete
PC Backup program can do this for you, or you can use a third-
party program.

As an alternative to doing a full disk backup, most third-party
disk-backup programs made for Windows 7 include an option to
back up the system portion of the Registry. If you use this
option, be sure to include all user profiles (everything under
\User) so that personal Registry sections are saved as well.

Check your backup software’s manual for instructions on saving
Registry and system information when you back up. I suggest
that you always include the Registry in your backups.

28

A caution

The backup programs provided with
Windows 7 do not provide a good
means of backing up the Registry as
insurance against accidents.
Windows Backup can perform only
full-volume backups, which can take
a long time. System Restore backs
up only HKEY_LOCAL_MACHINE, not

your own HKEY_CURRENT_USER data.
It’s okay to use only if you’re modify-

ing just HKEY_LOCAL_MACHINE set-
tings.
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Backing Up with System Restore

If you will be changing only entries under HKEY_LOCAL_MACHINE, you can create a restore point to
back up a copy of this part of the Registry. To create a restore point, follow these steps:

1. Click Start. Right-click Computer and select Properties. Then, at the left, select System
Protection. (Alternatively, type sysdm.cpl in a Command Prompt window, and then select the
System Protection tab.)

2. Be sure that the disk volume that contains Windows is checked, and click Create.

3. Enter a description for the restore point, such as Before changing Registry, and then click
Create.

Then, edit the Registry as described later in this chapter.

Backing Up with the Registry Editor

The Registry Editor has a mechanism to export a set of Registry keys and values to a text file. If you
can't or won't use a more comprehensive backup system before you manually edit the Registry, at
least use this editor to select and back up the key that contains all the subkeys and values you plan
to modify. Remember, though, that Regedit cannot remove entries you added that were not in the
Registry before the backup!

To back up a key and its subkeys and values, follow these steps:
1. To run Regedit, click Start, and type regedit in the Search box.

2. When Regedit appears under Programs in the search results, select it and press Enter.
(Alternatively, type regedit in a Command Prompt window.)

3. Locate and select the key you plan to modify, or a key containing all the keys you plan to modify,
in the left pane.

4. Select File, Export.

5. Choose a location and filename to use to store the Registry keys. I usually use the desktop for
temporary files like this, so that I'll see them and delete them later.

6. Select All Files from the Save As Type list, and enter a name (possibly with an extension other
than .reg—for example, before.sav).

7. Click Save. The chosen key or keys are then saved as a text file.

Restoring the Registry

If you've made Registry changes that cause problems, you can try to remember each and every
change you made, re-enter the original information, delete any keys you added, and thus undo the
changes manually. Good luck! If you were diligent and made a backup before you started, however,
you can simply restore the backup and have confidence that the recovery is complete and accurate.



I
4&““ les,

Backing Up and Restoring the Registry 811

&

Supo®,

Signs of Registry Problems

Registry corruption can take two forms: Either the Registry’s database files can be dam-
aged by an errant disk operation, or information can be mangled by a buggy program or an
overzealous regedit user. No matter what the cause, the result can be a system that won't
run or one that reboots itself over and over.

These could be other signs of Registry corruption or errors:
B Drivers aren't loaded, or they give errors while Windows is booting.
B Software complains about components that aren't registered or cannot be located.
B Undesirable programs attempt to run when you log in.

B Windows does not boot, or it starts up only in Safe mode.

If you made a Registry backup using a third-party disk or Registry backup tool, use the instructions
that came with your product to restore the Registry. If you created a restore point or used Regedit,
follow the steps described in the following sections.

Restoring the Registry from a Restore Point

If you created a restore point before modifying the Registry, you can back out the change by follow-
ing these steps:

1. Click Start. Right-click Computer and select Properties. At the left, select System Protection.
Then, click the System Restore button. (Alternatively, type rstrui in a Command Prompt win-
dow.)

2. Locate the restore point you created. Select it and click Next; then click Finish. Windows will
restart.

If the Registry problem is severe enough that Windows can't boot or get to the System Restore
function, you can perform a system restore from the system recovery tools on your Windows setup
DVD. See “Using System Recovery” on page 738 for instructions for performing a system restore
this way.

Restoring the Registry from Regedit

If a Registry editing session has gone awry and you need to restore the Registry from a key you
saved from within Regedit, follow these steps:

1. In Regedit, select File, Import.
2. Select All Files from the Files of Type list.
3. Locate the file you used to back up the Registry key or keys—for example, before.reg.

4. Select Open.

28
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The saved Registry keys are then imported, replacing any
changes or deletions. However, any keys or values you've
added to the Registry are not removed. If they are the cause
of the problem, this restore will not help.

If the Registry problems persist, you can try a rather drastic
measure: You can use Regedit to delete the key or keys that
were changed and then import the backup file again. This
time, any added keys or values are removed. I suggest that
you try this approach only with keys related to add-on soft-
ware, not for any of the Microsoft software or hardware keys.

Using Regedit

W tip
If you encounter what you think are
Registry problems with add-on soft-
ware, your best bet is to uninstall
the software, if possible, and rein-
stall it before attempting any
Registry restores or repairs.

Most people never need to edit the Registry by hand because most Registry keys are set by the

software that uses them. However, you might need to edit the Registry by hand if you're directed

by a technical support person who's helping you fix a problem, or when you're following a pub-

lished procedure to make an adjustment for which there is no Control Panel setting.

In the latter case, before going any further, I need to say this one last time, to make it absolutely

clear: Unless you're quite certain that you can't make a mistake, back up the Registry (or at least

the section you want to change) before making any changes.

The next few sections cover the basics of the Registry Editor.

Viewing the Registry

The Registry Editor doesn’t have a Start menu item. The easi-
est way to run it is to type regedit into the Search field on
the Start menu. When regedit appears in the results pane
under Programs, take one of the following actions, depending
on your needs:

B If you are logged on as an Administrator, press Enter or
click regedit. When the User Account Control dialog box
appears, click Continue. The Registry Editor will run with
full elevated privileges.

B If you are not logged on as an Administrator but need to
change settings in only the HKEY_ CURRENT_USER section
of the Registry, press Enter or click regedit. The Registry
Editor will run with reduced privileges, and you will not be
able to change systemwide settings.

u note

The reason for these complicated
variations is that malicious programs
and email attachments can easily
abuse the Registry Editor, so it’s sub-
ject to UAC restrictions. The Registry
Editor must be running in elevated
mode to modify Registry keys that
are secured to be changeable only by
the Administrator. By the way, there
is no indication in the Registry
Editor’s title bar to tell whether it’s
running with elevated privileges—
you just have to remember.

B If you are not logged on as an Administrator but need to change systemwide settings in
HKEY_LOCAL_MACHINE, right-click regedit and select Run as Administrator. Enter an
Administrator account’s username and password. The Registry Editor will then run with full ele-

vated privileges.
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Regedit displays a two-pane display much like Windows Explorer, as shown in Figure 28.1. The top-
level keys, which are listed below Computer, can be expanded just like drives and folders in
Explorer. In the pane on the right are the values for each key. The name of the currently selected

key appears in the status bar.
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Values have names, just as the files in a folder do, and it's in the values that configuration informa-
tion is finally stored. Each key has a (Default) value, which is the value of the key itself, and any
number of named values. For example, Figure 28.1 shows the key HKEY_CURRENT_USER\Control
Panel\Desktop. The value of HKEY_CURRENT_USER\Control Panel\Desktop itself is undefined
(blank), and the value HKEY_CURRENT_USER\Control Panel\Desktop\DragFullWindows is 1.

Registry values have a data type, which is usually one of the types shown in Table 28.1. The
Registry Editor display lists values by their technical names.
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Data Types Supported by Regedit

Technical Name “Friendly” Name Description

REG_SZ String value
REG_BINARY Binary value
hexadecimal digits.
REG_DWORD DWORD (32-bit) value
REG_QWORD QWORD (64-bit) value

Textual information, a simple string of letters.

Binary data, displayed as an arbitrary number of

A single number displayed in hexadecimal or decimal.

A single number displayed in hexadecimal or decimal.

QWORD values are used primarily by 64-bit Windows

applications.

REG_MULTI_SZ  Multistring value

A string that can contain more than one line of text.

REG_EXPAND_SZ Expandable string value Text that can contain environment variables (such as

%STEMP).

Other data types, such as REG_DWORD BIG_ENDIAN and REG_RESOURCE_LIST, exist, but they are

obscure and rare and can't be edited with Regedit.

Searching in the Registry

You can search for a Registry entry by key name, value name,
or the contents of a value string. First, select a starting point
for the search in the left pane. You can select Computer to
select the entire Registry, or you can limit your search to one
of the top-level keys or any subordinate key. Next, select Edit,
Find from the menu and enter a search string in the Find dia-
log box. The Find feature is not case sensitive, so it doesn't
matter whether you use upper- or lowercase letters. You can
check any of the Look At boxes to designate where in the
Registry you expect to find the desired text: in the name of a
key, in the name of a value, or in the data, the value itself.

Check Match Whole String Only to search only for items
whose whole name or value is the desired string.

Click Find Next to start the search. The Regedit display indi-
cates the first match to your string; by pressing F3, you can
repeat the search to look for other instances.

Also remember that Windows 7 might store information in
some places you are not familiar with, as discussed previously
under “New Registry Features.”

Editing Keys and Values

Regedit has no Save or Undo menu items. Changes to the
Registry happen immediately and permanently. Additions,
deletions, and changes are for real. This is the reason for all
the warnings to back up before you poke into the Registry.

u- note

When | search the Registry, most of
the time, | check all the Look At
boxes but not Match Whole String
Only.

W tip
The search function has two limita-
tions:

* You can’t enter a backslash (\) in
the search string when looking for
a key or value name; Regedit
won’t complain, but it won’t find
anything, either.

® You can’t search for the initial
HKEY_xxx part of a key name.
That’s not actually part of the
name; it’s just the section of the
Registry in which the key resides.

For example, to find a key named
HKEY_CLASSES_ROOT\MIDFile\she
11\Play\Command, you can’t type
all that in and have Find jump right
to the key. If you already know the
full pathname of a key, use the left
pane of Regedit to browse for the
key directly.
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To add a value to a key, select the key in the left pane and choose Edit, New. Select the type of
value to add; you can select any of the supported Registry data types, which are listed by the

“friendly” names shown previously in Table 28.1. The instructions you're following indicate which

type of value to add. A new value entry then appears in the right pane.

Type the new value's name and press Enter to edit the value:

B For string values, enter the text of the desired string.

B For DWORD values, choose Decimal or Hexadecimal, and enter the desired value in the chosen

format.

B For binary values, enter pairs of hexadecimal characters as instructed. (You'll never be asked to

do this, I promise.)

Changing a Value

If you want to change a value, double-click it in the right pane
to bring up the Edit Value dialog box. Alternatively, right-click it
and select Modify. Then make the desired change and click OK.

That is all you will likely ever need to do with Regedit.
However, in the extremely unlikely case that you want to delete
a value or add or remove a key, the following sections can help
see you through these processes.

Deleting a Value

If you've added a Registry value in the hope of fixing some
problem and found that the change wasn't needed, or if you're
instructed to delete a value by a Microsoft Knowledge Base arti-
cle or other special procedure, you can delete the entry by
viewing its key and locating the value on the right pane.

Select the value and choose Edit, Delete from the menu, or
right-click and select Delete from the context menu. Confirm by
clicking OK.

Adding or Deleting a Key

U— note

Many of the keys that control
Windows itself have access restric-
tions and can be modified only by an
Administrator.

4 caution

There is no Undo command in the
Registry Editor—when you delete a
value, it’s gone for good. Be sure
you’ve made a Registry backup
before editing or deleting Registry
keys and values.

Keys must be added as subkeys of existing keys; you can't create a new top-level key. To add a key,
select an existing key in the left pane and select Edit, New, Key from the menu. Alternatively, right-
click the existing key and select New, Key from the context menu. A new key appears in the left
pane, where you can edit its name. Press Enter after you enter the name.

You can delete a key by selecting it in the left pane and choosing Edit, Delete from the menu, or by
right-clicking it and selecting Delete from the context menu. Click OK to confirm that you intend to
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delete the key. Deleting a key deletes its values and all its subkeys as well, so without the protec-
tion of Undo (or a Registry Recycling Bin), this action is serious.

Renaming a Key

4 caution
As you have probably guessed, the pattern for renaming a key Don’t attempt to rename keys with-
follows the Explorer model exactly: Choose the key in the left out a very good reason—for exam-
pane and select Edit, Rename, or right-click the key and select ple, because you mistyped the name
Rename. Finally, enter a new name and press Enter. of the key you were adding. If

Windows can’t find specific Registry
keys it needs, Windows might not

Using Copy Key Name boot or operate correctly.

As you have probably noticed by now, the names of Registry

keys can be quite long, tortuous things. The Registry Editor offers a bit of help to finger-fatigued
Registry Editors (and authors): Choosing Edit, Copy Key Name puts the name of the currently
selected key into the Clipboard so you can paste it elsewhere if you need to.

Editing Registry Entries for Another User

As an administrator, you might find it necessary to edit HKEY_USER entries for another user. For
example, a startup program in HKEY_ CURRENT_USER\Software\Windows\CurrentVersion\Run
might be causing such trouble that the user can't log on. If you can't log on as that user, you can
edit his HKEY_CURRENT_USER Registry keys in another way:

1. Log on as an Administrator and run Regedit.
2. Select the HKEY_USERS window.

3. Highlight the top-level key HKEY USERS.

4. Select File, Load Hive.

5. Browse to the profile folder for the desired user. For a local user account, this is in
\Users\username. (For a Windows Server domain, look in the folder used for user profiles on
the domain controller.) The folder name of this folder might have the computer name or a
domain name attached. For example, on one computer, my profile folder name is
bknittel.java.

6. Type the filename NTUSER.DAT. (The file will most likely not appear in the Browse dialog box
because it's super hidden: marked with both the Hidden and System attributes.) Then click
Open.

7. A dialog box appears, asking you to enter a name for the hive. HKEY_ USERS normally loads user
hives with a long numeric name, so I suggest that you type the user’s logon name. Click OK. The
user’'s Registry data is then loaded and can be edited, as shown in Figure 28.2.
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8. When you're finished editing, unload the hive. Select the key you added under HKEY_USERS (for
example, daves_key in Figure 28.2), and select File, Unload Hive. Confirm by clicking Yes on the

warning dialog box.

Editing Registry Entries for Another Windows Installation

If you need to retrieve Registry entries from an installation of Windows installed on another hard
disk or partition, you can load any of that installation’s hive files for editing or exporting.

To edit the other installation’s Registry, you need to locate its hive files. They are usually found in
the locations shown in Table 28.2.

Table 28.2 Usual Location of Hive Files

Key

HKEY_LOCAL_MACHINE \ SAM
HKEY_LOCAL_MACHINE\Security
HKEY_LOCAL_MACHINE\Software
HKEY_LOCAL_MACHINE\System

HKEY_LOCAL_MACHINE\Components

HKEY_USERS\ .Default

Default Location and Hive File

\windows\system32\config\sam

\windows\system32\config\security

\windows\system32\config\software

\windows\system32\config\system

\windows\system32\config\components

\windows\system32\config\default




vi

818 Editing the Registry

To edit another Windows installation’s Registry, use the technique I described under “Editing
Registry Entries for Another User,” but instead of locating a user's NTUSER. DAT file, locate the
desired hive file on the other hard drive or partition. Unload it after you've exported or corrected the

desired information.

In some cases, you will find that you cannot view or modify
keys loaded from another installation. This occurs if the keys
are protected with security attributes that list specific users or
groups defined in the other installation. In this case, you need
to first take ownership of the keys and then add yourself as a
user who is authorized to read or change the keys. The next
section describes this.

Editing Registry Security

Tmp 07 LS AT

Just as files and folders in an NTFS-formatted disk partition
have security attributes to control access based on user and
group identity, Registry keys and values also have a complete
set of Access Control attributes that determine who has rights
to read, write, and modify each entry.

If you absolutely must change permissions or auditing controls,
locate the desired key or value, right-click it, and select
Permissions. The Permissions dialog box looks just like the com-
parable dialog box for files and folders (see Figure 28.3), and
lets you set read, write, and modify rights for specific groups
and users. You'll find a corresponding set of audit settings.

Figure 28.3
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Q note

You rarely should have to modify
Registry security settings, but it
does happen. The usual case is that
an incorrectly designed program
places information in a subkey of
HKEY_LOCAL_MACHINE\Software
that is intended to be shared and
modified by all users running the
program. Because Windows does
not permit standard users to modify
any keys in HKEY_LOCAL_MACHINE\
Software by default, the program
might malfunction. Modifying per-
missions so that standard users can
edit the shared key is sometimes
necessary to fix the problem.
Microsoft also sometimes recom-
mends modifying Registry security in
emergency security bulletins.

Registry key permissions control which users or groups are
/| allowed to see or modify the Registry key and its values.
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In most cases, a software vendor supplies precise instructions for making changes necessary to
work around an application problem. Here, I describe a general procedure to make a given key
readable and writeable by all users. You might do this to make a key capable of sharing information
between users, or to repair an alternate Windows installation, as mentioned in the previous section.
To set more generous permissions, follow these steps:

1. Locate and select the key in the left pane.
2. Right-click it and select Permissions.

3. Select the Users entry in the top Group or User Names section. If Users is not listed, click Add,
type Users, and click OK.

4. In the lower section, check Full Control and then click Apply. If this is successful, click OK.

5. If you are unable to make the changes even though you're running the Registry Editor as an
Administrator, click Advanced and select the Owner tab.

6. If the Current Owner is listed as unknown, select Administrators in the lower list and click OK.

7. Click OK to close the Advanced Security Settings dialog box, and return to Step 3.

This is a risky procedure because it could result in another user or application being unable to
access its own Registry keys. Use this as a procedure of last resort.

Other Registry Tools

There are some third party tools that you can use to edit the registry and adjust Windows features.
Here are four of the more popular utilities.

X-Setup Pro

X-Setup Pro by Xteq offers nearly 1,700 settings and tweaks using a slick graphical Explorer-like
interface. It includes wizards for some of the more complex tasks, such as mapping file types to
Explorer icons. One of its niftiest features is its capability to record a series of changes to a log file
that it can then play back on other computers. The cost is $20. You can download it from www.
x-setup.net.

Registry Toolkit

Registry Toolkit is a shareware Registry Editor made by Funduc software, with a nifty search-and-
replace system. You can scan the Registry, changing all occurrences of one string to another, which
is something most other Windows Registry Editors can't do. Its user interface isn't very comfortable
or slick, but if you need to manage a lot of identical changes in the Registry, this is one cool tool. It's
free to try, $25 to register, at www.funduc.com.
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Registrar Registry Manager

Registrar Registry Manager is a powerful Registry-editing tool produced by Resplendence Software
Projects (www.resplendence.com), with a drag-and-drop interface. It includes a Registry backup,
restore, and defragmentation tool, a Registry-compare tool, an undo capability, and many more fea-
tures. The full version costs €45 (about $63), and there is a free “lite” version.

Tweak-7

Tweak-7 from Totalidea Software, available at www.totalidea.com, combines tweaking tools with
additional enhancements and plug-ins. The cost is $39.99 for one computer, with multiple-license
discounts available.

Registry Privileges and Policies

On Windows corporate “domain”-type networks, administrators can use the policy system to
restrict users’ ability to change their computer configuration. When you log on using a Domain user
account, the policy system downloads and installs Registry settings prepared by system administra-
tors. These Registry settings not only can help automate the setup of networking and other compo-
nents, but can also restrict your ability to (mis)manage your computer.

Here's how it works: Windows looks at a boatload of Registry entries to determine what features to
make available to you. For example, one value determines whether the Start menu is allowed to dis-
play the Run item; another makes the Control Panel hide the Power Management settings. Most of
these values normally don't appear in the Registry at all, but they can be installed there by the pol-
icy system, and Windows security settings prevent users from changing or deleting them.

= On a computer that’s a member of a Windows Domain network, the policy system is called
Group Policy. On a standalone computer, it’s called Local Security Policy. Local Security Policy is
described in more detail under “Tightening Local Security Policy” on page 934.
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CHAPTER 9

Policing Windows 7
with Group Policies

A policy is a temporary creed liable to be changed, but while it
holds good it has got to be pursued with apostolic zeal.

—Mahatma Gandhi

You’ve seen in many places throughout this book that
you can perform some pretty amazing things by using a
tool that’s about as hidden as any Windows power tool can
be: the Local Group Policy Editor. That Microsoft has buried
this program in a mostly untraveled section of the
Windows landscape isn’t the least bit surprising, because in
the wrong hands, the Local Group Policy Editor can wreak
all kinds of havoc on a system. It’s a kind of electronic
Pandora’s box that, if opened by careless or inexperienced
hands, can loose all kinds of evil upon the Windows world.

Of course, none of this doom-and-gloom applies to you,
dear reader, because you're a cautious and prudent wielder
of all the Windows power tools. This means that you'll use
the Local Group Policy Editor in a safe, prudent manner,
and that you'll create a system restore point if you plan to
make any major changes. I knew I could count on you.

As you see in this chapter, the Local Group Policy Editor
isn’t even remotely hard to use. However, it’s such a power-
ful tool that it’s important for you to know exactly how it
works, which will help ensure that nothing goes awry when
you're making your changes.

Understanding Group Policies

Put simply, group policies are settings that control how
Windows works. You can use them to customize the
Windows 7 interface, restrict access to certain areas, specify
security settings, and much more.

IN THIS CHAPTER

» Understanding Group Policies

v

Local Group Policy Editor and
Windows Versions

» Launching the Local Group

Policy Editor
Working with Group Policies

» Group Policy Examples
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Group policies are mostly used by system administrators who want to make sure that
novice users don't have access to dangerous tools (such as the Registry Editor) or who
want to ensure a consistent computing experience across multiple machines. Group poli-
cies are also ideally suited to situations in which multiple users share a single computer.
However, group policies are also useful on single-user standalone machines, as you’ve seen
throughout this book.

Local Group Policy Editor and Windows Versions

The power of the Local Group Policy Editor is aptly illustrated not only by the fact that
Microsoft hides the program deep in the bowels of the system, but most tellingly by the
fact that Microsoft doesn’t even offer Local Group Policy Editor in the following Windows
versions:

» Windows 7 Home Basic

» Windows 7 Home Premium

In earlier versions of Windows, this tool was also removed from Windows XP Home,
Windows Vista Home Basic, and Windows Vista Home Premium. In other words, those
Windows versions that Microsoft expects novices to be using are the same Windows
versions where Microsoft doesn’t even include the Local Group Policy Editor, just to be safe.

Of course, plenty of experienced users use these Windows versions, mostly because they’re
cheaper than high-end versions such as Windows 7 Ultimate. So what'’s a would-be policy
editor to do when faced with having no Local Group Policy Editor?

The short answer is: Don’t sweat it. That is, although the Local Group Policy Editor does
provide an easy-to-use interface for many powerful settings, it’s not the only way to put
those settings into effect. Most group policies correspond to settings in the Windows
Registry, so you can get the identical tweak on any Windows 7 Home system by modify-
ing the appropriate Registry setting, instead. Throughout this book, I've tried to augment
group policy tweaks with the corresponding Registry tweak, just in case you don’t have
access to the Local Group Policy Editor.

TIP

Understanding that most group policies have parallel settings in the Registry is all fine
and dandy, but how on earth are you supposed to know which of the Registry’s thou-
sands upon thousands of settings is the one you want? The old method was to export
the Registry to a REG file, make the change in the Local Group Policy Editor, export the
Registry again, and then compare the two files. Way too much work (and impossible if
all you have to work with is a Windows Home version)! You can also try filtering the
policies as described later (see “Filtering Policies”). Fortunately, Microsoft has an
Excel workbook that lists every single group policy value and gives the corresponding
Registry setting. You can download the Group Policy Settings Reference, which covers
both Windows Vista and XP (no sign of a Windows 7 version as | write this), here:
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www.microsoft.com/downloads/details.aspx?FamilylD=41DC179B-3328-4350-ADE1-
COD9289F09EF

NOTE

Given a setting that you can tweak using either the Local Group Policy Editor or the
Registry Editor (and assuming you're running a version of Windows that comes with the
Local Group Policy Editor), which tool should you choose? | highly recommend using the
Local Group Policy Editor, because (as you'll see) it offers a simpler and more straight-
forward user interface, which means it saves time and you’ll be much less likely to
make an error.

Launching the Local Group Policy Editor

As T've said, you make changes to group policies using the Local Group Policy Editor, a
Microsoft Management Console snap-in. To start the Local Group Policy Editor, follow
these steps:

1. Press Start.
2. Type gpedit.msc.
3. Press Enter.
Figure 9.1 shows the Local Group Policy Editor window that appears. (The word Local

refers to the fact that you're editing group policies on your own computer, not on some
remote computer.)
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FIGURE 9.1 You use the Local Group Policy Editor to modify group policies on your PC.
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Working with Group Policies

The Local Group Policy Editor window is divided into two sections:

» Left pane—This pane contains a tree-like hierarchy of policy categories, which is
divided into two main categories: Computer Configuration and User Configuration.
The Computer Configuration policies apply to all users and are implemented before
the logon. The User Configuration policies apply only to the current user and, there-
fore, are not applied until that user logs on.

» Right pane—This pane contains the policies for whichever category is selected in
the left pane.

The idea, then, is to open the tree’s branches to find the category you want. When you
click the category, its policies appear in the right pane. For example, Figure 9.2 shows the
Local Group Policy Editor window with the User Configuration, Administrative Templates,
Start Menu and Taskbar category highlighted.
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FIGURE 9.2 When you select a category in the left pane, the category’s policies appear in the

right pane.
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TIP

Windows comes with another tool called the Local Security Policy Editor, which displays
only the policies found in the Local Group Policy Editor Computer Configuration,
Windows Settings, Security Settings branch. To launch the Local Security Policy Editor,
select Start, type secpol.msc, and press Enter. As you might expect, this snap-in isn’t
available in the Windows 7 Home editions.

In the right pane, the Setting column tells you the name of the policy, and the State
column tells you the current state of the policy. Click a policy to see its description on the
left side of the pane, as shown in Figure 9.3. If you don’t see the description, click the
Extended tab.
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FIGURE 9.3 Click a policy to see its description.

Configuring a Policy

To configure a policy, double-click it. The type of window you see depends on the policy:

» For simple policies, you see a window similar to the one shown in Figure 9.4. These
kinds of policies take one of three states: Not Configured (the policy is not in effect),
Enabled (the policy is in effect and its setting is enabled), and Disabled (the policy is
in effect but its setting is disabled).

NOTE

Take note of the Supported On value in the dialog box. This value tells you which ver-
sions of Windows support the policy.
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FIGURE 9.4 Simple policies are Not Configured, Enabled, or Disabled.

» Other kinds of policies require extra information when the policy is enabled. For
example, Figure 9.5 shows the window for the Items Displayed in the Places Bar poli-
cy (described in detail later in “Customizing the Places Bar”). When the Enabled
option is activated, the various text boxes become enabled, and you use them to
type paths for folders you want to display in the Places bar.
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FIGURE 9.5 More complex policies also require extra information, such as a list of folders to
display in the Places bar.
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Filtering Policies

I've been saying for years that the Local Group Policy Editor desperately needs a search
feature. There are nearly 3,000 policies and they’re scattered around dozens of folders.
Trying to find the policy you need by rooting around in the Local Group Policy Editor is
like trying to find a particularly small needle in a particularly large haystack. The Local
Group Policy Editor in Windows Vista included a rudimentary filtering feature, but it rede-
fined the word useless.

Fortunately, although the Windows 7 version of the Local Group Policy Editor still isn't
searchable (unless you export it to a text file by selecting Action, Export List), it does come
with two new features that make it quite a bit easier to track down a wayward policy:

» The two Administrative Templates branches (one in Computer Configuration and
the other in User Configuration) each come with a new sub-branch called All
Settings. Selecting this branch displays a complete list of all the policies in that
Administrative Templates branch. (Almost all non-security-related policies are in the
Administrative Templates branches, so that’s why they get singled out for special
treatment.)

» A beefed-up filtering feature that’s actual useful for cutting the vastness of the policy
landscape down to size.

In combination, these two features make it much easier to find what you're looking for.
The basic idea is that you select the All Settings branch that you want to work with, and
then set up a filter that defines what you’re looking for. Local Group Policy Editor then

displays just those policies that match your filter criteria.

To show you how this works, let’s run through an example. Suppose I want to find the
Items Displayed in Places Bar policy shown earlier in Figure 9.5. Here’s how I'd use a filter
to locate it:

1. Select the User Configuration, Administrative Templates, All Settings branch.

2. Select Action, Filter Options to open the Filter Options dialog box.
3. Make sure the Enable Keyword Filters check box is activated.
4

. Use the Filter for Word(s) text box to type a word or phrase that should match the
policy you're looking for. In our example, we know that “places” is part of the policy
name, so I'll use that as the filter text.

5. Use the associated drop-down list to choose how you want the policy text to match
your search text:

» Any—Choose this option to match only those policies that include at least one
of your search terms.

» All—Choose this option to match only those policies that include all of your
search terms in any order.

» Exact—Choose this option to match only those policies that include text that
exactly matches your search phrase.
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6. Use the Within check boxes to specify where you want the filter to look for matches:

» Policy Setting Title—Select this check box to look for matches in the policy
name. In our example, “places” is part of the policy name, and it’s a relatively
unique term, so it should suffice to only filter on the title, as shown in Figure
9.6.

» Explain Text—Select this check box to look for matches in the policy descrip-
tion.

» Comment—Select this check box to look for matches in the Comments text.
(Each policy comes with a Comments box that you can use to add your two-
cent’s worth about any policy.)

7. Click OK.
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FIGURE 9.6 In the Windows 7 Local Group Policy Editor, you can use the Filter Options dialog
box to find the policy you need.

With your filter in place, select Action, Filter On (or click to activate the Filter button in
the toolbar). The Local Group Policy Editor displays just those policies that match your
filter settings. For example, Figure 9.7 shows the results when the filter in Figure 9.6 is
turned on. As you can see, the Items Displayed in Places Bar policy is among the results.
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FIGURE 9.7 The results when the filter set up in Figure 9.6 is turned on.

Group Policy Examples

Although there are plenty of examples of group policies in action throughout this book,
I'm a firm believer that you can’t get enough of this powerful tool. With that in mind, the
rest of this chapter takes you through a few of my favorite policies.

Customizing the Windows Security Window

When you press Ctrl+Alt+Delete while logged on to Windows 7, you see the Windows
Security window, which contains the following buttons, as shown in Figure 9.8:

» Lock This Computer—Click this button to hide the desktop and display the Locked
window. To return to the desktop, you must enter your Windows 7 user account
password. This is useful if you're going to leave Windows 7 unattended and don't
want another person accessing the desktop. However, Windows 7 offers a faster way
to lock the computer: Press Windows Logo+L.

» Switch User—Click this button to switch to a different user account while also
leaving your current user account running.

» Log Off—Click this button to display the Welcome screen, which lets you log on
using a different user account.

» Change a Password—Click this button to display the Change Password window,
which enables you to specify a new password for your account.

» Start Task Manager—Click this button to open Task Manager.

Of these five commands, all but Switch User are customizable using group policies. So if
you find that you never use one or more of those commands, or (more likely) if you want
to prevent a user from accessing one or more of the commands, you can use group poli-
cies to remove them from the Windows Security window. Here are the steps to follow:
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FIGURE 9.8 In Windows 7, press Ctrl+Alt+Delete to display the Windows Security dialog box.

1. Open the Local Group Policy Editor window, as described earlier in this chapter.

2. Open the User Configuration, Administrative Templates, System, Ctrl+Alt+Del
Options branch.

3. Double-click one of the following policies:

» Remove Change Password—You can use this policy to disable the Change a
Password button in the Windows Security window.

» Remove Lock This Computer—You can use this policy to disable the Lock
Computer button in the Windows Security window.

» Remove Task Manager—You can use this policy to disable the Start Task
Manager button in the Windows Security window.

» Remove Logoff—You can use this policy to disable the Log Off button in the
Windows Security window.

4. In the policy dialog box that appears, click Enabled and then click OK.
5. Repeat steps 3 and 4 to disable all the buttons you don’t need.

Figure 9.9 shows the Windows Security window with the four buttons removed.

To perform the same tweak using the Registry (see Chapter 12, “Tweaking the Windows 7
Registry”), open the Registry Editor and open the following key:

HKCU\Software\Microsoft\Windows\CurrentVersion\Policies\System
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FIGURE 9.9 You can use group policies to remove most of the buttons in the Windows
Security dialog box.

Change the value of one or more of the following settings to 1:
DisableChangePassword

DisableLockWorkstation
DisableTaskMgr

To remove the Log Off button via the Registry, open the following key:
HKCU\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer

Change the value of the NoLogoff setting to 1.

Customizing the Places Bar

The left side of the old-style Save As and Open dialog boxes in Windows 7 include icons
for several common locations: Recent Places, Desktop, Libraries, Computer, and Network,
as shown in Figure 9.10.

NOTE

If you display the Save As or Open dialog box and you see the Navigation pane instead,
it means the application uses the updated dialog boxes. However, you can still cus-
tomize the Favorites section: To add a folder, drag it from the folder list and drop it on
Favorites; to remove a custom shortcut from the Favorites list, right-click it, click
Delete, and then click Yes when Windows asks you to confirm.
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FIGURE 9.10 The old Save As and Open dialog boxes display icons on the left for common
locations.

The area that contains these icons is called the Places bar. If you have two or more folders
that you use regularly (for example, you might have several folders for various projects
that you have on the go), switching between them can be a hassle. To make this chore
easier, you can customize the Places bar to include icons for each of these folders. That
way, no matter which location you have displayed in the Save As or Open dialog box, you
can switch to one of these regular folders with a single click of the mouse.

The easiest way to do this is via the Local Group Policy Editor, as shown in the following
steps:
1. Open the Local Group Policy Editor window, as described earlier in this chapter.
2. Open the following node: User Configuration, Administrative Templates, Windows
Components, Windows Explorer, Common Open File Dialog.
3. Double-click the Items Displayed in Places Bar policy.
4. Click Enabled.

5. Use the Item 1 through Item 5 text boxes to type the paths for the folders you
want to display. These can be local folders or network folders, as shown earlier in

Figure 9.5.
6. Click OK to put the policy into effect. Figure 9.11 shows a dialog box with icons for
the folders from Figure 9.5 displayed in the Places bar.

If you don’t have access to the Local Group Policy Editor, you can use the Registry Editor
to perform the same tweak. Open the Registry Editor and navigate to the following key:

HKCU\Software\Microsoft\Windows\CurrentVersion\Policies\
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FIGURE 9.11 A dialog box showing the custom Places bar.

Now follow these steps:

1. Select Edit, New, Key, type comd1g32, and press Enter.

Select Edit, New, Key, type Placesbhar, and press Enter.

Select Edit, New, String Value, type Place@, and press Enter.

Press Enter to open the new setting, type the folder path, and then click OK.

o w N

Repeat steps 3 and 4 to add other places (named Place1 through Place4).

NOTE

If you don’t use the Places bar at all, you might prefer to hide it to give yourself more
room in the old Open and Save As dialog boxes. To do that, open the Local Group
Policy Editor and navigate to the User Configuration, Administrative Templates, Windows
Components, Windows Explorer, Common Open File Dialog branch. Double-click the
Hide the Common Dialog Places Bar, click Enabled, and then click OK.

Increasing the Size of the Recent Documents List

In Chapter 5, “Customizing the Start Menu and Taskbar,” I showed you how to customize
the Windows 7 Start menu to include the Recent Items menu. Clicking Recent Items
displays a list of the 15 documents you worked on most recently. If you find that a docu-
ment you need often doesn’t appear on this list, even though you did use it recently, it’s
likely that 15 documents isn’t enough for you. In that case, you can use a group policy to
configure Windows 7 to display a higher number of recent documents.

» To learn how to add Recent Items to the Start menu, see “Streamlining the Start
Menu by Converting Links to Menus,” p. 96.
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Here are the steps to follow to customize the size of the Recent Items list:

1. Open the Local Group Policy Editor window, as described earlier in this chapter.

2. Navigate to the User Configuration, Administrative Templates, Windows

Components, Windows Explorer branch.

3. Double-click the Maximum Number of Recent Documents policy.
4. Click Enabled.

Use the Maximum Number of Recent Documents spin box to specify the number of
documents you want Windows 7 to display.

. Click OK.

NOTE

You can specify a value between 1 and 9,999 (!) in the Maximum Number of Recent
Documents spin box. If you specify more documents than can fit vertically on your
screen, Windows 7 adds scroll buttons to the top and bottom of the My Recent
Documents list.

Enabling the Shutdown Event Tracker

When you select Start, Shut Down, Windows 7 proceeds to shut down without any more
input from you (unless any running programs have documents with unsaved changes).
That’s usually a good thing, but you might want to keep track of why you shut down or
restart Windows 7, or why the system itself initiates a shutdown or restart. To do that, you
can enable a feature called Shutdown Event Tracker. With this feature, you can document
the shutdown event by specifying whether it is planned or unplanned, selecting a reason
for the shutdown, and adding a comment that describes the shutdown.

Here are the steps to follow to use a group policy to enable the Shutdown Event Tracker
feature:

o o wbd PR

Open the Local Group Policy Editor window, as described earlier in this chapter.
Navigate to the Computer Configuration, Administrative Templates, System branch.
Double-click the Display Shutdown Event Tracker policy.

Click Enabled.

In the Shutdown Event Tracker Should Be Displayed list, select Always.

Click OK.

Now when you select Start, Shut Down, you see the Shut Down Windows dialog box shown
in Figure 9.12. The Shutdown Event Tracker group gives you three new controls to operate:
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FIGURE 9.12 The Shut Down Windows dialog box appears with the Shutdown Event Tracker
feature enabled.

» Planned—Leave this check box activated if this is a planned shutdown. If you didn’t
plan on shutting down Windows 7 (for example, you're restarting because a program
has crashed or because the system appears unstable), deactivate this check box.

» Option—Use this list to select the reason for the shutdown. (Note that the items you
see in this list change depending on the state of the Planned check box.)

» Comment—Use this text box to describe the shutdown event. If you choose either
Other (Planned) or Other (Unplanned) in the Option list, you must add a com-
ment to enable the OK button; for all other items in the Option list, the comment
text is optional.

To enable the Shutdown Event Tracker on systems without the Local Group Policy Editor,
open the Registry Editor and dig down to the following key:

HKLM\Software\Policies\Microsoft\Windows NT\Reliability
Change the value of the following two settings to 1:

ShutdownReasonOn
ShutdownReasonUI




Safa rl New Decade, More Knowledge
0 11,500 Books & Videos, 1 Monthly Price

Books Online

Make 2011 the year you expand what you know, and learn something
new outside the box. Learn how you can grow and gain insight in
current and new skill areas. Whether you want to learn at home,

the office, or on-the-go, Safari Books Online brings you your tech-
nology, creative and business library when and where you need it.

Learn what you want and more — anytime, anywhere — with
Safari Books Online:

Quickly find specific information in more than 11,500 books and
videos from O’Reilly Media, Addison-Wesley, Microsoft Press,
Cisco Press, Wiley, Apress, Adobe Press and other top publishers.

Watch hundreds of expert-led instructional videos on today’s
hottest topics. From C#, Java and Objective-C 2.0, to Windows
7, Adobe CS4 and Twitter, we've got you covered.

Gain a competitive edge by being the first to learn about the
newest technologies and subjects. Access pre-published manu-
scripts and interact with the authors by using our Rough Cuts.

Round out your overall skill set with an extensive business cat-
egory of books and videos in the library. That’s more than 1,000
extra resources you will be able to access in the near future.

Save time with the ability to copy and paste code, create
searches that automatically update, and customize your library
with favorites, highlights, tags, notes, mash-ups and more.

Be sure to also check out m.safaribooksonline.com and bring
Your Library to Android, Blackberry, and any mobile device with
a browser.

See for yourself! To help you get started, we are offering a special
10 day free trial, plus a 30% discount on a monthly Safari Library
subscription—for a whole year. That’s a savings of up to $156!
Start your free trial now.

llustrator

5 ey

1 DAYS FREE
PLUS 30% OFF

Try Safari Books
Online risk free for

10 days. Subscribe to
the Safari Library plan
and pay only $29.99
per month for the

first 12 months—

save up to $156!*

{ TRY SAFARINOW! |

| J

Safari Library: Unlimited access
to books,videos, pre-published
manuscripts, plus five free
download tokens per month to
download chapters or full books

Price after trial:

$42:99 $29.99/month
for the first 12 months
* Offer expires 3/31/11.


www.safaribookonline.com
www.safaribookonline.com
http://my.safaribooksonline.com/home?subpage=anonUItrial&portal=informit
http://my.safaribooksonline.com/home?subpage=anonUItrial&portal=informit
http://safaribooksonline.com/Corporate/Index/

I“'nrm -com THE TRUSTED TECHNOLOGY LEARNING SOURCE

PEARSON InformIT is a brand of Pearson and the online presence

— for the world’s leading technology publishers. It's your source
for reliable and qualified content and knowledge, providing
access to the leading brands, authors, and contributors
from the tech community.

#Addison-Wesley ~Cisco Press ExaAv/CcRAM IBM - gue 3 PRENTICE  §4MS | Safari®

Press.

LearniT at InformiT

Looking for a book, eBook, or training video on a new technology? Seeking
timely and relevant information and tutorials. Looking for expert opinions,
advice, and tips? InformIT has a solution.

e | earn about new releases and special promotions by
subscribing to a wide variety of monthly newsletters.
Visit informit.com/newsletters.

e FREE Podcasts from experts at informit.com/podcasts.

e Read the latest author articles and sample chapters at
informit.com/articles.

e Access thousands of books and videos in the Safari Books
Online digital library. safari.informit.com.

e Get Advice and tips from expert blogs at informit.com/blogs.
Visit informit.com/learn to find out all the ways you can access the
hottest technology content.

Are you part of the IT crowd?

Connect with Pearson authors and editors via RSS feeds, Facebook,
Twitter, Youtube and more! Visit informit.com/socialconnect.

SEEN K

IninrmlT-com THE TRUSTED TECHNOLOGY LEARNING SOURCE

#Addison-Wesley Cisco Press ExaMcrAm IBM  gue 33 PRENTICE  gAMS | Safari”

Press. — ee PALL SIS S o



www.informit.com
www.informit.com
www.informit.com
www.informit.com
safari.informit.com
http://www.informit.com/blogs/
http://www.informit.com/articles/
http://www.informit.com/podcasts/
http://www.informit.com/promotions/promotion.aspx?promo=136778
http://www.informit.com/newsletters/
http://www.informit.com/
http://www.informit.com/promotions/promotion.aspx?promo=135479

W B

tutorials web sidebars

more than just a book

USING IS MORE THAN JUST A BOOK:
it's the fastest, easiest way to gain the

technology skills you're looking for!

mtmmnm "
With USING books and eBooks, you don't D & C

just read about it: You see it and hear it with
step-by-step video tutorials and valuable
audio sidebars delivered through the windows 7
Free Web Edition that comes with ever :
USING book and eBook.

PR v Junil & b FrCie B jik & Bk

=) G 2]

For the price of the book, you get
online access anywhere with a web wordpress facebook
connection—no books to carry,
updated content, and the benefit
of video and audio learning.

Visit quepublishing.com/using
for a complete list of published

and coming soon USING titles. microscft ,
power -a;-_u__'lut

m quepublishing.com


www.quepublishing.com
www.quepublishing.com
www.quepublishing.com/store/product.aspx?isbn=0789743264
www.quepublishing.com/store/product.aspx?isbn=0789742918
www.quepublishing.com/store/product.aspx?isbn=0789745240
www.quepublishing.com/store/product.aspx?isbn=0789746344
www.quepublishing.com/store/product.aspx?isbn=0132182734
www.quepublishing.com/store/product.aspx?isbn=0789742942
www.quepublishing.com/imprint/series_detail.aspx?st=87407
http://www.quepublishing.com/imprint/series_detail.aspx?st=87407

quepublishing.com

Buinborne & Maiag e

QUEPUBLISHING.COM P

Your Publisher for Home & Office Computing

Quepublishing.com includes all your favorite—
and some new—Que series and authors to help you
learn about computers and technology for the home,
office, and business.

Graphics, Mcures & Vides
Looking for tips and tricks, video tutorials, articles and
interviews, podcasts, and resources to make your life
easier? Visit quepublishing.com. Cipmraiing Syyirmy

Friarmat £ Weh Aaps

L]
ek Beilpn & Devefapriiend 9

« Read the latest articles and sample chapters
by Que’s expert authors

QUE NEWSLETTER
- Free podcasts provide information on the quepublishing.com/newsletter

hottest tech topics

twitter.com/

- Register your Que products and receive updates, quepublishing

supplemental content, and a coupon to be used
on your next purchase facebook.com/

quepublishing

o

« Check out promotions and special offers
available from Que and our retail partners youtube.com/

(s

. . . quepublishing
+ Join the site and receive members-only offers

and benefits quepublishing.com/

[iSS]

2

Que Publishing is a publishing imprint of Pearson



www.quepublishing.com/
www.quepublishing.com/
www.quepublishing.com/
www.quepublishing.com/
www.quepublishing.com/topics/
www.quepublishing.com/topics/index.aspx?st=87408
www.quepublishing.com/imprint/series_detail.aspx?st=87407
www.quepublishing.com/topics/topic.aspx?st=87018
www.quepublishing.com/topics/topic.aspx?st=87019
www.quepublishing.com/topics/topic.aspx?st=87020
www.quepublishing.com/topics/topic.aspx?st=87021
www.quepublishing.com/topics/topic.aspx?st=87022
www.quepublishing.com/topics/topic.aspx?st=87023
www.quepublishing.com/topics/topic.aspx?st=87024
www.quepublishing.com/topics/topic.aspx?st=87025
www.quepublishing.com/topics/topic.aspx?st=87026
www.quepublishing.com/topics/topic.aspx?st=87027
www.quepublishing.com/articles/index.aspx
www.quepublishing.com/podcasts/index.aspx
https://memberservices.informit.com/my_account/register.aspx?partner=71&r=http%3a%2f%2fwww.quepublishing.com%2fstore%2fregister.aspx
http://www.quepublishing.com/promotions/
https://memberservices.informit.com/my_account/register.aspx?partner=71&r=http%3a%2f%2fwww.quepublishing.com%2fstore%2fregister.aspx
http://twitter.com/quepublishing
http://www.facebook.com/QuePublishing
http://www.youtube.com/QuePublishing
http://www.quepublishing.com/rss/
http://www.quepublishing.com/newsletters/index.aspx

SamsTeachYourself

from Sams Publishing

Sams Teach Yourself
in 10 Minutes offers
straightforward, practical
answers for fast results.

These small books of 250 pages
or less offer tips that point out
shortcuts and solutions, cau-
tions that help you avoid common
pitfalls, and notes that explain
additional concepts and provide
additional information. By working
through the 10-minute lessons,
you learn everything you need to
know quickly and easily!

When you only have time for the
answers, Sams Teach Yourself
books are your best solution.

Visit informit.com/
samsteachyourself for
a complete listing of the
products available.

Sams Publishing is a Pearson brand and part of the family of bestselling technology publishers.
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